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1. INTRODUCTION 

1.1 What is the COMMUTER model? 

The COMMUTER model (subsequently referred to as simply “COMMUTER”) is a 
spreadsheet-based computer model that estimates the travel and emissions impacts of 
transportation air quality programs focused on commuting. The model is particularly 
useful for programs such as those recognized under the EPA’s Best Workplaces for 
CommutersSM and other Commuter Choice Programs. 

1.2 Who will use COMMUTER? 

EPA designed COMMUTER for two types of users: 

•	 Metropolitan Planning Organizations (MPOs) and state Departments of 
Transportation (DOTs) who are assessing emissions impacts of various 
Transportation Control Measure Strategies. These impacts can be incorporated 
into State Implementation Plan (SIP) analyses. 

•	 Individual employers who are assessing the likely effectiveness of various 
commuter benefit packages and other measures to facilitate use of commute 
alternatives. 

MPOs and DOTs can also provide guidance and assistance to employers participating in 
voluntary programs on the application of this tool. 

1.3 Why was COMMUTER created? 

COMMUTER was designed to help simplify the effort required by air quality planners to 
estimate travel and emission effects resulting from Transportation Control Measures. The 
model can also be used to estimate the benefits of site-specific Commuter Choice 
(employer-based transportation) programs to assist employers in designing a program 
appropriate for them. 

The 1990 Clean Air Act Amendments mandated that the EPA and DOT provide guidance 
on “the formulation and emission reduction potential of transportation control measures 
related to criteria pollutants and their precursors” (Section 108(f)). In the early 1990s, 
EPA developed a number of tools and guidance documents to assist communities in 
developing these measures and taking credit for the resulting emission reductions. 
Because the effects of TCMs on travel activity and emissions can be very complex, the 
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guidance included many aspects of vehicle operation and other factors that affect 
emissions. The guidance documents were often very detailed and difficult to use. 

COMMUTER consolidates existing TCM guidance, and is based on “state-of- practice” 
methodologies and data. COMMUTER will reduce the time required to calculate the 
benefits of regional and employer-based TCMs. It will also save regional government 
resources, since these governments will have less need to develop their own models and 
tools. 

1.4 What Programs can I evaluate with COMMUTER? 

You can use COMMUTER to evaluate these types of programs, either for a defined 
region within an urban area, or for individual employers: 

•	 Transit fare decreases or other incentives that reduce the cost of using transit; 

•	 Transit service improvements (faster or more frequent service); 

•	 Ridesharing programs, in which employers support carpooling and/or vanpooling 
through on-site programs, financial incentives, or preferential parking; 

•	 Other actions, such as increased parking charges or cash-out programs, that 
change the time and/or cost of traveling by any particular mode; 

•	 Non-motorized (e.g., bicycle and pedestrian) commuting programs; 

•	 Alternative work schedules, including flex-time, compressed work weeks, and 
staggered work hours; and 

•	 Telecommuting. 

1.5 What methodology does COMMUTER use? 

COMMUTER is broken down into two components: travel impacts and emissions 
impacts. 

The travel impacts component uses a logit mode-choice model referred to as the “pivot 
point” approach. This approach allows you to analyze the effects of several strategies 
simultaneously. Mode choice models have been developed for many cities and regions 
nationwide, so you can often use coefficients that have already been developed to reflect 
local characteristics. This component will calculate the impact of the mode share changes 
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from these programs and translate the mode share changes into changes in trips and 
vehicle miles traveled (VMT). In addition, COMMUTER contains an input option that 
allows you to enter mode share changes directly (such as might be obtained from 
employee survey data) as an alternative to the pivot point-based calculation performed 
internally by the model. 

The emissions component is based on EPA’s MOBILE6.2 model. MOBILE6.2 emission 
factors were generated and loaded into COMMUTER for several sets of local conditions. 
You can select the conditions most appropriate for your area, and the model will apply 
the corresponding emission factors in calculating and outputting emission reduction 
impacts. If you are an experienced MOBILE6.2 user, you can also generate your own set 
of MOBILE6.2 emission factors (reflecting your exact local conditions) that can be 
imported into COMMUTER. In fact, if you intend to use COMMUTER to produce 
emissions reduction estimates for SIP submittals or conformity determinations, your 
emission outputs from COMMUTER must be based on an imported MOBILE6.2* run 
using your own local or state information. See the BWC SIP and Conformity Guidance 
for more information on how to include control measures from BWC programs in SIPs 
and conformity determinations. 

1.6 When can I use COMMUTER, and when should I not use it? 

COMMUTER is particularly useful for smaller Transportation Control Measures and can 
be used for the purpose of calculating State Implementation Plan (SIP) credit or for 
conformity determinations. The model will not perform as well for larger programs, 
particularly those large enough to impact travel speeds throughout an area. If your 
program is likely to have a regionally significant effect on travel patterns**  it must be 
analyzed within the modeling performed by the MPO during its regional emissions 
analysis You should consult with your regional EPA office if you believe your program 
can have these impacts. In this case, you can still use COMMUTER to calculate an 
initial estimate of a potential program. You may want to do this to help you select a 
program and determine if you want to further consider particular options. 

* EMFAC is required for SIP modeling in California. COMMUTER does not have the ability to import 
EMFAC emission factor output. 

** 40 CFR 93.101 defines a “regionally significant” project as “a transportation project (other than an 
exempt project) that is on a facility which serves regional transportation needs (such as access to and from 
the area outside of the region, major activity centers in the region, major planned developments such as new 
retail malls, sports complexes, etc., or transportation terminals as well as most terminals themselves) and 
would normally be included in the modeling of a metropolitan area's transportation 
network, including at a minimum all principal arterial highways and all fixed guideway transit facilities that 
offer an alternative to regional highway travel.” 
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IMPORTANT: COMMUTER is not designed to quantify baseline 
travel or emissions.  Instead, its purpose is to estimate travel and 
emission changes associated with specific measures, based on 
inputs you provide.  Thus, although COMMUTER may be used to 
calculated SIP credits for these measures, the baseline travel or 
emissions estimates it generates will not exactly match your 
baseline SIP inventory. 

The COMMUTER Model is most appropriately applied to a single worksite, employment 
center, or subarea for sketch-level analysis purposes. Its most robust predictive power 
lies with measures that can be translated into time and cost strategies. The factors used 
for employer support and alternative work arrangements are based on the best research 
and professional judgment available. In most cases, though, the empirical evidence to 
support these factors is very limited. Furthermore, the impacts of any one type of 
program can vary substantially, depending upon the characteristics of the worksites being 
evaluated, the employees who work there, and how effectively a given program is 
implemented. For some planning purposes, therefore, it may be necessary to gather 
additional empirical data and/or conduct more detailed modeling, in order to increase the 
reliability of the estimate of a program’s impacts. 

1.7 What do I need to do to get started? 

In order to run the model, you will need to gather background information about the 
travel characteristics in your area. MPOs or Councils of Government (COGs) generally 
compile this information for an area. Regional COGs are local government organizations 
designed to study and recommend solutions to problems facing an individual region and 
to help their local government members apply effective, coordinated regional planning. 
MPOs are similar organizations that focus on transportation-related planning. 

If you are an employer or other non-MPO user of this model, you should contact the MPO 
or COG in your area. The National Association of Regional Councils (NARC) maintains 
an Internet website at http://www.narc.org. From the NARC home page, you can access 
information about the Association of Metropolitan Planning Organizations (AMPO) and 
lists of COG and MPO links by state (http://www.narc.org/links/member.html). If you are 
unsure of the appropriate source, you should consult with your regional EPA office to find 
the appropriate source of information. 
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You will also need specific background information for your particular program. This 
user manual will assist you in determining the appropriate inputs into the model. Again, 
if you have any further questions, you can consult with your regional EPA office. 

1.8 What other documentation is available? 

This user manual presents the key instructions needed for you to effectively develop 
inputs and run COMMUTER. Although it attempts to provide you with enough 
information to understand how to develop inputs and operate the model, it is not 
exhaustive in detail. If you are interested in further understanding the theory behind the 
modeling calculations, please consult the companion document to this user manual, 
“Procedures Manual for the COMMUTER Model v2.0.”1* 

1.9 What has Changed Compared to COMMUTER Version 1.0? 

COMMUTER Model version 1.0 was originally released in 2000. Version 2.0, released 
in 2005, incorporates a number of updates and changes to calculation procedures, to make 
use of the most recently available travel and emissions data and to expand the model's 
capabilities. Significant changes include the following: 

•	 The default travel parameters (e.g., mode shares, trip lengths) have been updated 
using data from the 2000 U.S. Census, the 2001 Nationwide Household 
Transportation Survey, and other recent sources. 

•	 The default and area-specific mode choice coefficients have been updated based 
on a review of current national practice. Default coefficients are no longer 
provided for different area sizes, since a review of the coefficients did not find 
significant differences among urban areas of different sizes. 

•	 Some of the TCM impact values embedded in the model have been updated, 
based on recent research. These include the mode share impacts for "level 3" and 
"level 4" carpooling and vanpooling support, and default participation level for 
telecommuting programs. 

•	 Emissions are now calculated using MOBILE6.2, EPA's most current version of 
the MOBILE emission factor model, rather than MOBILE5b. 

•	 Emissions are reported for seven additional pollutants, including particulate 
matter (PM2.5, users can get PM10 output by importing their own MOBILE6.2 
runs with PM10 output) and six air toxics, as well as for the four pollutants 
originally reported by COMMUTER - volatile organic compounds (VOC), carbon 
monoxide (CO), oxides of nitrogen (NOx), and carbon dioxide (CO2). Emissions 
for some pollutants are now reported in pounds per day as well as in tons per day. 

* Superscripts denote references provided in Section 6. 
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•	 The procedure for calculating emissions changes has been revised for consistency 
with MOBILE6.2 format emissions data. Additional user inputs may be 
specified, including the percentage of vehicle-miles of travel (VMT) by facility 
type, and average travel speeds for both freeways and arterials in both the peak 
and off-peak periods. On the other hand, user inputs for the percentage of cold 
starts are no longer required. 
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2. USING THE MODEL


This section explains how to install COMMUTER and provides a general overview of 
how to run each element of the program, as well as how to view and save your results. 
Further details on the type of data required are provided in Section 3 (for general existing 
condition inputs), Section 4 (TCM-specific information), and Section 5 (emissions­
related information). 

2.1 What type of computer equipment and software do I need? 

COMMUTER runs on personal computers using Microsoft’s Windows 95 or later 
operating systems. You must also have Microsoft Excel 95 (i.e., Excel 7.0) or a more 
recent version of Excel installed.  If your computer allows you to run these programs, you 
can use COMMUTER. (However, if you have a Pentium-class CPU with less than 150 
MHz, moving through the input screens may be slow at times.) 

COMMUTER will work at 640 x 480, 800 x 600, and 1,024 x 768 display resolutions at 
both 250-color and 16-bit (Hi-Color) depths, and should run at any available video 
display setting. 

The COMMUTER model itself requires a minimum of 2.0 MB of disk space. In 
addition, the default MOBILE6 emission factors that may be used with the model are 
provided in 192 external tab-delimited data files (.tbz) that require 12.2 MB when zipped 
or 47.4 MB when unzipped. If disk space is a concern, the user may choose to retain only 
the files that are relevant to their analysis area. If the user chooses to provide their own 
MOBILE6 outputs, the output file will require approximately 40 MB of disk space. 

2.2 How do I install and operate COMMUTER? 

Installing the Program 

Installing COMMUTER is quite simple. The model, along with some sample files, is 
contained in the COMM1.EXE self-extracting archive file (which can be downloaded 
from EPA’s web site at http://www.epa.gov/otaq/transp.htm). Step-by-step installation 
instructions are given as follows. 

Step 1 - Create a new folder or directory on your computer where you want to install 
and operate COMMUTER (e.g., C:\COMMUTER). (When you run COMMUTER, it 
can create and re-use “scenario” files that store your data and assumptions for a 
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particular analysis case or scenario. Thus, it is highly recommended that you create a 
separate folder for COMMUTER so these files don’t get mixed up with others.) 

Step 2 - Download or copy the COMMUTER_v20.ZIP file to your computer and 
unzip it, directing it to deploy all files to the folder or directory you just created. 

When this is complete you should have a folder entitled “COMMUTER_v20" within 
the directory you’ve chosen with the following items: the model itself, 
COMMUTER_v20.xls; an example scenario file entitled Example Scenario_v20.vme; 
a sample MOBILE6.2 input file entitled M6sample.in; and a folder entitled Data 
containing 192 files with a .tbz extension. These files contain data related to the 
Petroleum Administration for Defense Districts (PADDs) that are needed to compute 
changes in emissions of air toxics. It is important that the Data folder be in the same 
folder as COMMUTER_v20.xls. If the Data folder is in a different location, 
COMMUTER will be unable to access the files. 

Finally, you should check your macro security level in Excel to ensure that it is set on 
“Medium.” This is done by opening the “Tools” menu, selecting “Macro,” and then 
selecting “Security.” You will have a choice of High, Medium, or Low security. Select 
Medium. COMMUTER’s macros will not run if the security level set to High, and Low 
is not recommended. 

Running the Program 

Once you have installed the program, there are several different ways that you can run the 
program. 

•	 Create and launch a shortcut to the application; 

•	 Double-click* the COMMUTER_v20.xls file from within the Windows Explorer 
or Internet Explorer window (assuming Excel has been installed and associated 
with .XLS file types); 

•	 Right-click the COMMUTER_v20.xls file and click “Open” from the pop-up 
menu; or 

•	 Click the Start button at the bottom left of the Windows desktop, select 
“Documents” from the pop-up menu, and then click the COMMUTER_v20.xls 
file from the pop-up list of documents. (This method will work only if you have 

*  If the Windows Explorer has been replaced by Internet Explorer (e.g., in Windows 98), Internet Explorer 
can be configured to launch programs with a single mouse click instead of a double-click. 
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recently opened the COMMUTER_v20.xls file and it still appears in your 
“Recent Documents” list.) 

You cannot run the program by launching a previously created scenario file (.vme) from 
the Windows desktop. Scenarios must be opened from within the program after it has 
been launched in one of the ways described above. As the program launches you will see 
a dialogue box stating that the file has macros and asking you to choose when to disable 
the macros or enable them. Select “Enable Macros.” As the program loads, you will see 
a startup screen like the one shown below in Figure 1. 

Figure 1

COMMUTER Startup Screen


COMMU T E R  MODE L 
COMMU T E R CH OI CE  & VOL U N T AR Y MOB I L E  S OU R CE P R OGR AM 

T R AVE L AND E MI S S I ONS  ANAL YS I S  T OOL 

Release 
1.0 

INPUT LEGEND

 - REQUIRED INPUT
 - OPTIONAL INPUT
 - LOCKED CELLS 
- PROGRAM-CONTROLLED CELLS

 - HELP TEXT 

The startup screen includes an “input legend” showing the colors that are used to identify 
the different types of cell ranges that you will see on the data entry screens. Different 
colors are used to identify cells that you type inputs into and to highlight on-screen help 
boxes as listed below: 

• light green - required input cells; 
• yellow - optional input cells; 
• white - locked (i.e., non-editable) cells; 
• gray - program-controlled cells; and 
• red - help text boxes. 
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Required inputs must be typed into all light-green cells shown in the edit screens. You 
can also supply inputs in the yellow shaded cells, but the program will run if they are left 
blank. (However, it is a good idea to use these optional input cells to supply more 
information about the analysis scenario you are constructing.) White and gray cells are 
locked from editing and are used to display information. Finally, red cells highlight help 
boxes containing brief instructions for the inputs being entered on each screen. 

NOTE: When the program has finished loading, you will see a 
“Ready” indicator at the bottom left of the application window. 

The user interface for COMMUTER has been programmed to display on your entire 
screen (i.e., in “full” screen). If you need to temporarily minimize the COMMUTER 
application to the Windows taskbar (located at the bottom of the Windows desktop by 
default), type “Ctrl-m” (i.e., hold down the Ctrl key and type “m”). To restore the 
COMMUTER application to the full screen, just click its button in the Windows taskbar. 

2.3 How do I begin once the program is installed? 

Once the program finishes loading, you can select from four main menus listed at the top 
of the screen: the File menu, the Edit Inputs menu, the Results menu, and the Help menu. 
These menus will be available at the start of every session, and will allow you to enter 
data (Edit Inputs menu), view results (Results menu), print results (File menu), get help 
(Help menu), and retrieve or save data and results for a specific analysis (referred to as a 
“scenario”, accessed through the File Menu). 

Figure 2 shows the structure of the main menu, which includes the “File,” “Edit Inputs,” 
“Results,” and “Help” menus, and each of the sub-menu elements. 

You will generally begin an analysis by clicking through the data entry elements in the 
Edit Inputs menu in the order in which they are listed in the menu. (Once you have 
defined an analysis, you can later load and edit a scenario from the File menu; this will be 
discussed later in Section 2.6.) Each of the elements in the Edit Inputs menu corresponds 
to the input screens for entering specific data required by COMMUTER. (Detailed 
information on the data required for these screens is provided in Sections 3-5.) 
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Figure 2

Menu Structure


File Menu Edit Inputs Menu


Results Menu Help Menu 

When the program is first loaded, some of the sub-menu elements shown in the Edit 
Inputs menu will be shown as gray shaded-out text, which indicates that you have not yet 
selected any TCM programs for analysis. (As explained below, you will make these 
selections by using the check boxes at the bottom of the Scenario Information screen.) 

2.4 How do I input data? 

The Edit Inputs menu lists each of the input screens available. Some of the screens are 
for inputting baseline (i.e., existing condition) information needed regardless of the type 
of TCM being analyzed; others will be used only when analyzing a particular measure. 
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IMPORTANT: The program will automatically size the width of 
the data entry screens to the width of your monitor. However, the 
length of some of the screens will exceed the monitor’s vertical 
display dimension. Therefore, for some input screens (such as the 
Scenario Information and Local Data screens), you must scroll to 
the bottom of the screen to complete the data entry required in that 
screen by using the vertical scroll bar or the “Down Arrow” or 
“Page Down” keys. 

The information that must be entered in each input screen is listed in Table 1. The data 
required in the first three screens (“Scenario Information,” “Local Data,” and “Edit 
Coefficients”) consist of general information, background travel data, and mode-choice 
coefficients. 

Table 1 
Summary of COMMUTER Data Inputs 

Input Screen Data Required 

Scenario Information 
General information, including area size and scope (i.e., regional vs. site-
specific) being analyzed and the TCM programs being evaluated 

Local Data 
Background travel data such as existing mode shares, trip lengths, 
occupancy levels, baseline vehicle miles traveled, baseline speeds, and 
option to provide final mode shares (after TCMs) 

Edit Coefficients 
Provides default mode choice coefficients as a function of the area size 
entered earlier and for selected cities, which can be edited by the user 

Site Access & Transit 
Service Improvements 

Data required for analysis of either site access or transit service 
improvement TCMs, including changes in site access walk times and 
employer participation rates, and transit headway and route travel time 
changes 

Financial Incentives & 
Parking Costs 

Inputs for analysis of financial and parking incentive programs consisting 
of changes in parking, transit fare, or other costs by travel mode 

Site-Specific Employer 
Support Programs 

Parameters that specify either the program participation level or expected 
mode share increase resulting from the implementation of an employer 
(i.e., site) specific commuter choice program 

Area-Wide Employer 
Support Programs 

Employer participation level inputs required for area-wide analysis of 
commuter choice programs being implemented across a metropolitan area 
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Table 1 
Summary of COMMUTER Data Inputs 

Alternative Work 
Schedules 

Existing and expected eligibility or participation rates for alternative work 
schedule programs being evaluated, such as flex time, compressed work 
weeks, staggered hours, and telecommuting 

Fleet Emissions 
Information 

Inputs required by the program in order to either apply a pre-generated set 
of MOBILE6.2 fleet emission factors or to utilize locally generated 
MOBILE6.2 emission factors imported into the model 

Other Emissions-Related 
Data 

Fleet travel mix (e.g., fraction of travel by vehicle class) and start fraction 
inputs required by the program to calculate TCM emission reductions that 
are specific to the local conditions being modeled 

If you have not yet done any analyses or want to analyze a new scenario, you will start 
with the Scenario Information screen to enter general background information and to 
select the type(s) of TCM programs being evaluated. This selection is made by checking 
the appropriate boxes shown at the bottom of the Scenario Information screen. You can 
enter any non-blank character in the check boxes to activate analysis of the specific 
TCMs. 

Travel data should be entered using the Local Data screen, and you can use the Edit 
Coefficients screen to edit the default mode choice coefficients provided with the 
program. (Images of these screens and details on the data required are provided in 
Section 3.) By default, COMMUTER calculates changes in mode share due to the types 
and extent of specific TCM programs being modeled. If , however, you have estimates of 
changes in mode share due to modeled programs, you can optionally enter the final mode 
shares (resulting from changes to existing shares) in the Local Data screen. 

Data for the specific TCM program(s) being evaluated are entered in the next five 
screens. You will have access to only those screens that were selected (checked off) for 
analysis in the Scenario Information screen. Detailed information on these screens is 
provided in Section 4. 

NOTE: If you have chosen to enter your own final mode share 
estimates in the Local Data screen, you do not need to enter 
information in any of the TCM-specific program screens.  In this 
case, the inputs in these screens are bypassed and the final mode 
shares you have entered are used to compute VMT and trip impacts. 

13




Finally, you will enter emission-related data in the last two data screens (addressed in 
Section 5). This will include either vehicle fleet parameters that allow the program to 
find and apply a specific set of previously generated MOBILE6.2 emission factors that 
approximate local conditions being modeled, or selection of MOBILE6.2 emission 
factors that you have generated to more precisely reflect local conditions. 

NOTE: You may see a “Calculate” annunciator on the status bar 
at the bottom of the application window while you are entering 
data. This is normal.  During data entry, the program recalculates 
only specific portions of the underlying spreadsheets in order to 
speed up performance.  Later, when you view or print results or 
save the scenario data, all underlying sheets are recalculated. 

If you are only interested in computing travel impacts, you do not need to enter any 
emissions-related inputs in these last two screens. 

2.5 Is there help available when inputting data? 

From the Help menu, you can view a “Model Layout” screen that provides an overview 
of the layout and data flow of COMMUTER. The Model Layout screen also identifies 
the input screens that apply to specific voluntary measures and commuter choice 
programs. Figure 3 shows the Model Layout screen. Note that on smaller monitors, you 
may need to scroll down to view the entire screen. 

You can also return to the Startup screen from the Help menu. (This is handy if you need 
to refer to the cell coloring conventions used to guide you in entering model inputs.) 

In addition, many of the input screens offer additional guidance on the specific data that 
must be entered. In some screens, explanatory notes are shown next to the input cell. In 
other screens, “help boxes” displayed with light red backgrounds provide more extensive 
descriptions of key data inputs. 

Once you’ve finished inputting all the required data for each screen (remember that in 
some cases you may need to scroll down your screen to complete data entry), that screen 
will appear with a checkmark (�) beside it the next time the Edit Inputs menu is 
accessed. You can use the presence or absence of checkmarks as an easy visual reference 
of additional data that must still be entered. 
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Figure 3

Model Layout Screen


COMMUTER MODEL DATA LAYOUT 
(SCROLL DOWN TO VIEW ENTIRE LAYOUT SCREEN) 

GENERAL INPUT SCREENS 

SCENARIO INFORMATION LOCAL DATA MODE CHOICE MODEL COEFFICIENTS 
General Information Existing Mode Shares Choice of: 
Analysis Area Definition Existing Trip Length  National Defaults 
Analysis Area Employment Existing Occupancy  City-Specific Defaults 
TCM Programs Being Analyzed  Peak Period Info  User-Specified 

Observed Mode Shifts 
from TCMs (optional) 

TCM PROGRAM-RELATED INPUT SCREENS 

SITE-SPECIFIC PROGRAMS AREA-WIDE PROGRAMS 

SITE ACCESS IMPROVEMENTS (NO TRANSIT) SITE ACCESS & TRANSIT SERVICE IMPROVEMENTS 
Preferential Parking Preferential Parking 
Bicycle Lockers Bicycle Lockers 
New Transit Stops New Transit Stops 

More Frequent Transit Service 
Faster Transit Service 

FINANCIAL INCENTIVES & PARKING COSTS FINANCIAL INCENTIVES & PARKING COSTS 
Parking Cash-Out Parking Cash-Out 
Differential Parking Charges Differential Parking Charges 
Transit Incentives Transit Incentives 

SITE-SPECIFIC EMPLOYER SUPPORT PROGRAMS AREA-WIDE EMPLOYER SUPPORT PROGRAMS 
On-site Transportation Coordinator On-site Transportation Coordinator 
Ridematching Ridematching 
Outreach and Promotion to Employees Outreach and Promotion to Employees 

Outreach and Promotion to Employers 

ALTERNATIVE WORK SCHEDULES ALTERNATIVE WORK SCHEDULES 
Flex-time Flex-time 
Compressed Schedules Compressed Schedules 
Staggered Hours Staggered Hours 
Telework Telework 

EMISSIONS-RELATED INPUT SCREENS 

FLEET EMISSIONS INFORMATION (Optional) OTHER EMISSIONS-RELATED DATA (Optional) 
Inputs for Pre-Loaded MOBILE Factors Vehicle Fleet Mix

 Inputs for User-Supplied MOBILE Factors Affected Vehicle Speeds 
VMT Mix by Facility Type 

RESULTS SCREEN 

RESULTS 
Mode Shares & Changes 
Trip Changes 
VMT Changes 
Emission Reductions: 

HC (as VOCs) 
CO 
NOx 
PM 
CO2 
Air Toxics 
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2.6 Can I save my inputs to use in another analysis? 

Saving Scenarios - To make repeated use of COMMUTER quicker and easier, you can 
save a complete set of analysis inputs and re-use them later as a template for evaluating 
other scenarios. This avoids having to type in complete data from scratch for each 
analysis, but still allows you to modify selected data to evaluate alternatives. 

After inputting data for a specific analysis case, save the information to a “scenario file” 
(indicated by a “.VME” file extension). First click on the “File” menu and select “Save 
Scenario.” This will bring up a dialog box that allows you to save the file to disk for later 
use. Click the arrow to the right of the “Save in” box to select the directory where you 
want to save the file, then type a file name for the scenario to be saved in the “File name” 
box, using the .VME suffix. (To make it easier to find and use your files, you may want 
to save the “.VME” scenario files to the same folder or directory where the application 
program was stored, e.g., C:\COMMUTER.) 

Loading Saved Scenarios - When you want to load and re-use a saved scenario file, click 
the “Load Scenario” item from the File menu. Then, select the directory and the specific 
scenario file you saved earlier to be loaded into the application. Re-using existing 
scenarios and making minor changes to their inputs is a more efficient way to create a 
series of related scenarios than typing in all the data for each scenario. 

Clearing Scenarios - If for some reason you have loaded a scenario or have typed in data 
for all the input cells and want to delete the data from all the input cells and start over, 
you can click the “Clear Scenario” item on the File menu. This initializes the program by 
erasing the data currently contained in the input cells if you want to start re-entering all 
new data without having to exit and reload COMMUTER. It does not delete saved 
scenario files from your hard disk. 

2.7 Can I use my own emission factors? 

COMMUTER has been supplied with 192 sets of MOBILE6.2 emission factors that 
encompass a range of input conditions throughout the country. Each of these supplied 
data sets contains emission factors for six calendar years: 2007, 2009, 2010, 2013, 2019, 
and 2021. Under general circumstances when COMMUTER is used as a screening 
model, selecting the set of pre-loaded emission factors that best matches your local 
conditions is adequate. However, if you want to use COMMUTER to produce emission 
reductions reflecting local conditions, such as for SIP or conformity purposes, you must 
use your own locally generated MOBILE6.2 emission factors to calculate emission 
reductions in COMMUTER. The steps for using your own emission factors are 
explained below. 
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Step 1 - Create Properly Formatted Emission Factor Output File-Although you can 
specify your exact local input conditions, your MOBILE6.2 output emission factors 
must be generated in a specific format expected by COMMUTER. The sample 
MOBILE6.2 template input file M6SAMPLE.IN, which is provided with the model, 
identifies how specific commands in the MOBILE6.2 input file must be set to 
produce output emission factors in the COMMUTER-required format. In addition, it 
contains a series of 13 "Scenario" records that produce emission factors over a range 
of speeds expected by COMMUTER. These scenario records can be edited to reflect 
the altitude, calendar year, local ambient temperature, season of interest, and local 
fuels data. In addition, the user may specify other locality-specific data in the "Run 
Data" or "Scenario" sections, such as I/M programs, vehicle registration distributions, 
or alternative Tier 2 phase-in schedules. Speed data files for each scenario are 
provided with the model and should not be edited. 

In addition, the user must specify the "database output" option with the formats 
shown in the sample file. In addition, the user must specify calculation of particulates 
as well as air toxics, as shown in the sample file, and provide the fuel parameters and 
particulate emission factor inputs in each scenario record, as required by MOBILE6.2 
to calculate particulate and air toxics emissions. If these conventions are not 
followed, the resulting MOBILE6.2 model output will not work properly with 
COMMUTER. 

IMPORTANT: Once you’ve edited the 13 scenario records to 
reflect your own altitude, temperature, and season inputs, you can 
copy and paste this block of records to create emission factors for 
multiple calendar years. 

Once you have set up your MOBILE6.2 input file as described above and in 
accordance with the required database output options, run MOBILE6.2. You can 
name the MOBILE6.2 input and output files as you choose. 

Step 2 - Process MOBILE6.2 Output - Once you have run MOBILE6.2, an 
intermediate step is required to process MOBILE6.2 database-format output into the 
format expected by COMMUTER. You can run this step from inside the 
COMMUTER model using the "Process MOBILE6.2 Output" command from the 
"File" menu. This command will allow you to browse for and select a standard 
MOBILE6.2 database output file (.TB1) extension. It will then convert the data in 
this file into a text file suitable for import into COMMUTER, with a .TBZ extension. 
Note that corresponding toxics and PM MOBILE6.2 output files are also read (.TOX 
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and .PM extensions, respectively), and a corresponding VMT file (.VMT) is also 
generated that contains VMT fractions by vehicle type and facility type. The model 
user must retain these files in the same directory as the .TB1 and .TBZ files and 
should not delete them. The routine to process MOBILE output may take a few 
minutes to run; this is normal. 

Step 3 - Activate User-Supplied Emission Factors Option - On the "Fleet Emissions 
Information" input screen in COMMUTER, you have the option of selecting 
"User-Supplied Emission Factors." Once you have selected this option and specified 
a calendar year, you will be reminded to Import User Emission Factors, as described 
below. It is important that the calendar year you have specified match one of the 
calendar years included in the .TBZ file you select. 

Step 4 - Import User Emission Factors - Once you have generated a .TBZ file, you 
can import this file into the COMMUTER model using the "Import User Emission 
Factors" command from the "File" menu. This command will allow you to browse 
for and select a .TBZ file. You may select any .TBZ file that you already have 
generated from MOBILE6.2 output, without re-running the "process MOBILE6.2 
output" routine described above. Importing the .TBZ file will take a few seconds; 
you will be notified when the import routine has been successfully completed. These 
emission factors will be saved within the COMMUTER model until you import a 
different set of either user-specified or default scenario emission factors. 

2.8 How do I view the results? 

Once you have provided all of the required inputs (or selected default values), 
COMMUTER will automatically calculate TCM travel impacts and, if you’ve entered 
emission factor inputs, emission reductions.  To view the results, all you need to do is 
simply click either of the two command items on the Results menu.  “View Travel 
Results” displays travel impacts only.  “View Travel and Emission Results” shows both 
travel impacts and emission reductions (assuming you’ve entered emission factor inputs). 

You can then scroll down the tabular summary to see the calculated results.  Key outputs 
include the following: 

•	 Baseline and final mode shares for each mode, including percent of trips

eliminated and change in mode share (final minus baseline);


•	 Percent of trips shifted from the peak to off-peak period; 

•	 Baseline and final peak, off-peak and daily VMT; 
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•	 Baseline and final peak, off-peak and daily vehicle trips; and 

•	 Change in total daily emissions for each pollutant in tons per day and/or pounds 
per day. 

NOTE:  If you did not enter all of the necessary input data, an 
“Incomplete or Inconsistent Input” message box will be displayed 
when the View Travel Results or View Travel and Emission Results 
buttons are clicked. The message box indicates which data must 
still be entered.  If you click the OK button in the message box, the 
program will activate the first entry screen and cell for which 
missing or invalid data were detected. 

To return to an input screen after viewing the results calculated by COMMUTER, simply 
click the appropriate item in the Edit Inputs menu at the top of the application window. 

2.9 How do I print my data and results? 

For each scenario you evaluate, you can print both the detailed input data and the 
tabulated emission reductions. To do this, click the File menu. Then select “Print 
Inputs” from the drop-down menu to print a detailed listing of all program inputs. Select 
either “Print Travel Results” or “Print Travel and Emission Results” from the File menu 
to print a one-page output report showing travel impacts or travel impacts and emission 
reductions, respectively. 

Figure 4 shows the layout of a sample output report. General scenario information and 
the specific TCMs evaluated are listed at the top of the report. Included in these items are 
boxes that indicate whether you have supplied your own final mode shares and emission 
factors. Below these items, summaries of the combined mode share impacts and travel 
and emission reductions from baseline levels for all the TCMs selected are presented. As 
noted in the table headers, travel and emission reductions are shown as positive numbers. 
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Figure 4 
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1, 3-Butadiene 
Formaldehyde 
MTBE 

CO2 

tons/day: 
Pollutant Peak Off-Peak Total 
HC 
CO 
NOx 
CO2 
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CAUTION: The program allows you to set up a scenario and 
produce results for an individual TCM (as opposed to a 
combination of measures).  However, summing the results for 
measures evaluated individually will not give you an accurate 
representation of the true impact of a combination of measures. 

2.10 Can I tell the model to remember where my files are stored? 

Depending on how you launch COMMUTER (see Section 2.2), your “default” directory 
(the directory pointed to when you open or save files) may not be the same as the 
directory that the model and scenario files are stored in. You can tell the model where to 
look for your scenario (and emission factor) files so you don’t have to click out of the 
“system” default directory (e.g., C:\My Documents) each time you want to open or save a 
scenario. 

To set your default or “working” directory when you’re running COMMUTER, click 
“Set Working Directory” from the File menu. The first time you do this, COMMUTER 
will report that the working directory is blank as shown below. 

This is normal. Simply click the “Yes” button. Another window, shown below, will be 
displayed that then allows you to enter the disk drive and directory path where you’ve 
installed COMMUTER (e.g., C:\COMMUTER). 
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Once you have set the working directory, COMMUTER remembers that location and 
uses it each time you open or save scenario files or import your own emission factors, 
even if you exit and then re-run the model. 

2.11 What do I do when I’m finished? 

Before exiting COMMUTER, be sure you have saved the current inputs in a scenario file, 
as described above, if you plan to re-use them later. When you have completed your 
analysis session and want to exit COMMUTER, click “Exit Program” from the File 
menu. The application will then close and exit. 
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3. GENERAL INPUT SCREENS


This and the following two sections guide you step-by-step through the data that must be 
provided in each of the input screens. This section covers the first three screens, which 
you use to input general information; Section 4 explains the five input screens that are 
specific to individual TCMs being analyzed; and Section 5 discusses the two screens you 
will use to enter information required to calculate emission reductions. Each subsection 
within these sections corresponds to one of the program’s ten input screens. These have 
been ordered in the sequence in which you would generally enter data for an analysis. To 
make it easier to find information on specific data inputs, fields have been noted in bold, 
underlined text. 

3.1 Scenario Information 

Scenario information describes the area you are analyzing and the broad types of 
commuter choice programs to be analyzed. Figure 5 displays the layout of the Scenario 
Information screen. Key data items are explained below. 

Metropolitan Area Size - This is where you define the size of the metropolitan area you 
are analyzing, using the following categories: 

� Large - more than 2,000,000 in population; 
� Medium - 750,000 to 2,000,000 in population; and 
� Small - less than 750,000 in population. 

Based on the area size you select, the program will retrieve default travel speeds. You 
have the option to override the default speeds in the “Edit Emissions Data” screen with 
values you obtain for your city. 

Analysis Scope - The actual analysis can apply to any geographic level. However, you 
must define the scope of your analysis as being area-wide (“1”) or site-specific (“2”). 
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Figure 5

Scenario Information Input Screen


SCENARIO INFORMATION 

Field Data Notes 

Scenario Information 
Scenario Filename 
User EFs Filename 

Description 

Filename of scenario stored on disk 
User-supplied MOBILE emission factors (if used) 

Title to further identify the scenario (optional) 

General Information 
Performing Agency 
Address 
Analyst 
Metropolitan Area 

Metropolitan Area Size 

Name of your organization (optional)

Address of your organization (optional)

Your name (optional)

Name of city/area being modeled (optional)


1 = Large (Over 2 million)  2 = Medium (750,000

to 2 million)  3 = Small (Under 750,000)


Metropolitan Area Size is a required input.  The program retrieves default freeway and arterial travel speeds for the 
area size input by the user. However, these defaults for Large, Medium and Small metropolitan areas may not be 
as accurate as locally-derived travel speed data. These default travel speeds can be overridden in the "Edit Other 
Emissions-Related Data" screen. 

Definition of Analysis Area 

Analysis Scope 

Analysis Area/Site 

Analysis Area Type 

1 = Area-Wide (Metropolitan Area, County, etc)  2 
= Site or Employer-Based 
Name of analysis area evaluated (optional) 
1 = CBD (Central Business District) 2 = Other 
High-Density Commercial  3 = Other 

The COMMUTER model can be used to evaluate commuter choice programs on both an urban area-wide and 
individual employer (or site-specific) basis. The Analysis Scope input controls whether the model calculates area-
wide or site-specific impacts of commuter choice programs. 

Employment in Analysis Area 

Office Employment 

Non-Office Employment 

Total Employment -

Refers to "traditional" professional office space 
employment 
Manufacturing, warehousing, retail, medical, 
educational, entertainment and other employment-
generating land uses 

The COMMUTER model may generate abnormally large mode shifts under a regional or area-wide analysis 
scenario if realistic limits are not applied in estimating the affected employment input above. For site-specific 
analysis, enter the employment of the workplace being analyzed. For area-wide analysis, the user is encouraged to 
consult Section 3.1 of the COMMUTER Model User Manual for more detailed guidance on estimating affected 
employment inputs for region being modeled. 

Programs (Mark All Programs Being Analyzed with an "X") 
Includes preferential parking, improved access to 

1. Site Walk Access Improvements 
transit 
Includes more frequent and/or faster transit 

2. Transit Service Improvements 
service 
Includes parking costs, transit fare/pass 

3. Financial Incentives 
subsidies, or other financial incentives 
Includes support programs for carpooling, 

4. Employer Support Programs 
vanpooling, transit, and/or bicycling
Includes flex time, telecommuting, staggered work 

 5.  Alternative Work Schedules 
hours, and/or compressed work weeks 

24




An area-wide analysis evaluates TCM programs for a geographic area such as traffic 
corridors, subareas (for example, the central business district), activity centers (for 
example, a large office park complex), or the entire metropolitan region. A site-specific 
analysis evaluates TCM programs applied only to a single business or employer location. 
This option can be used when considering either a single place of business for a given 
employer or a mixed use or multi-purpose place of business for a given employer or 
employers.  If you are an individual employer using this model to evaluate a company 
employer support program, you should use the “site-specific” analysis. 

As discussed in Sections 4.3 and 4.4, you will later be asked for further data that are 
related to the scope you select. For example, if you specify “area-wide,” some screens 
will ask you to specify the percentage of employers in the area participating in the 
program. If “site-specific” is specified, this percentage will be assumed to be 100 
percent. (See Sections 4.3 and 4.4 for detailed instructions for inputting data for both 
area-wide and site-specific analysis.) 

Affected Employment in Analysis Area - The impact or applicability of various 
programs and strategies is affected by type of employees in an area, which COMMUTER 
defines according to the land use category of the employer.  “Office” employees are those 
working in land use categories that include traditional professional office space. 
“Non-office” employees include those working in manufacturing, warehousing, retail, 
medical, educational, entertainment, and other employment-generating land use activities. 

You will be asked to enter both the number of office and non-office employees in the area 
or at the target site that can be affected by the TCM programs being modeled. “Affected” 
is the keyword in understanding what employment levels you should input here and 
depends on whether you are performing a site-specific or area-wide analysis, as explained 
below. 

Site-Specific Affected Employment - If you are performing a site-specific or “single 
employer” analysis (specified by choosing “2” for Analysis Scope), the employment 
levels you enter should be the total of all employees that are eligible for, or exposed to, 
any or all of the TCM programs you are evaluating.  Most of the time, site-specific 
affected employment will be the total employment level at the site.  In rare cases where 
employer support, financial incentive, or alternate work schedule programs being 
evaluated would only be made available to a portion of all employees, enter that portion 
as the affected employment. 

Area-Wide Affected Employment - In an area-wide analysis, affected employment should 
not be entered as the total employment in the area being considered. You must estimate 
that subset of the total area employment that will be potentially affected by any or all of 
the specific TCM programs you are evaluating. 
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CAUTION: For area-wide analysis, you should not enter the total 
employment in the analysis area.  You do not want to base the 
analysis on the total employment in the analysis area because 
COMMUTER will then generate unrealistically high results for 
regional scenarios. For example, the number of trips being shifted 
from one mode of travel to another if all employees for a given 
region are assumed to participate in a voluntary program would be 
too high. 

Steps to help you calculate the number of employees that can be affected by the TCM 
programs you are evaluating under an area-wide analysis are listed below. 

1.	 First, identify the portion of regional employers (and number of employees) that are 
currently participating in existing programs, and therefore should be excluded from 
the analysis. You can obtain the percentages of employers (by size and type) from the 
MPO responsible for transportation and emissions planning in the region. Using the 
total number of employees for a region is not realistic. 

2.	 Finally, determine that portion of employers of a specific size (based on their number 
of employees) that will be subjected to, or encouraged to implement, the voluntary 
programs being evaluated. This percentage will vary by MPO region and could 
include either office or non-office employers with 1,000, 500, 250, or 100 employees. 

3.	 Next, estimate the portion of employers of each type (office and non-office) who will 
agree to participate in any of the TCM programs you are evaluating, which will 
largely be voluntary in nature. This percentage will vary by MPO region and could 
include office employers only or a combination of office and non-office employers. 

The following example is provided to demonstrate how you should use this process to 
determine the employment levels you need to enter under an area-wide analysis. 

Assume total employees for Region X:	 1,000,000 employees 

1.	 Estimate portion of total employees currently 
participating in existing TCM programs:	 20% -200,000 employees 

800,000 employees 

2. Estimate portion of remaining employees by size of 
employer targeted by your voluntary programs, using 
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employers of 500+ employees in this example: 

Office (500+ employers): 
Non-office (500+ employers): 

250,000 employees 
50,000 employees 

3. Determine portion of remaining employees based on 
estimated percentage of employers willing to 
participate in any of the modeled programs: 

(In this example we’ll assume 30% office and 
10% non-office employer participation) 

Office - 30% participation: 
Non-Office - 10% participation: 

75,000 employees 
5,000 employees 

Using this example, you would enter inputs of 75,000 and 5,000 employees for affected 
office and non-office employment, respectively. 

You should be careful in making assumptions about the number of affected employees in 
each region. Each region is likely to be significantly different based on the current 
participation in voluntary programs, employer and employee participation rates, and 
regional employment characteristics. 

As these steps and the example indicate, when inputting the “affected” employment under 
an area-wide analysis, you should supply estimates of the number of office and non-office 
employees that are eligible for participation in any of the specific TCM programs you are 
evaluating. 

NOTE: If you are evaluating a scenario that packages multiple 
programs (e.g., site access improvements, transit improvements, 
and financial incentives), individual “program” participation rates 
can also be specified in subsequent input screens for each program. 
You should not confuse these program-specific participation rates 
with the employer participation percentage in any program used to 
estimate affected employment inputs.  The program-specific 
participation rates in subsequently discussed input screens provide 
you with a means to “weight” the participation of all affected 
employees within individual programs when analyzing scenarios 
that combine multiple programs. 
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Programs - In this section, you simply check off which types of TCM strategies or 
programs are to be considered in the scenario being analyzed. There are five possible 
choices, described below. You simply mark (with an “X”) all of the programs being 
analyzed; you do not have to select only one. 

1. Site Walk Access Improvements - Includes preferential parking for employees 
using carpool and/or vanpool programs and improved access to transit systems. 

2. Transit Service Improvements - Includes more frequent and/or faster transit 
service. 

3. Financial Incentives - Includes any project or program that changes the out-of­
pocket cost of alternative travel modes relative to automobile travel. Examples 
include transit fare/pass subsidies, parking costs, or other financial incentives. 

4. Employer Support Programs - Includes support programs for carpooling, 
vanpooling, transit, and/or bicycling that do not result in any changes in direct 
travel time or cost changes. For example, employers might provide information 
about ridesharing and transit opportunities, match employees with carpools or 
vanpools, and offer guaranteed ride home programs. 

5. Alternative Work Schedules - Includes flex time, telecommuting, staggered work 
hours, and/or compressed work weeks. 

NOTE: If you are planning to enter your own estimate of final mode 
shares as described in the Local Data inputs in Section 3.2, 
COMMUTER will ignore any TCM programs you check here.  By 
inputting your own final mode shares, you are bypassing 
COMMUTER’s final mode share calculations that are based on 
TCM screen inputs. 

3.2 Local Data 

Once you have provided the general information on the scenario you are analyzing, you 
need to provide data on the existing travel behavior and characteristics of the area or site. 
Because travel characteristics such as mode shares (for example, transit users) and 
average travel distances can vary a great deal within a region, you should define separate 
geographic areas that have distinct and more or less homogenous characteristics for 
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analysis. For example, you may wish to conduct separate analyses for the central 
business district (CBD) and for the non-CBD portions of a city. 

Baseline (i.e., existing) travel data for the region of interest are entered in the Local Data 
input screen, shown in Figure 6. Each of the data elements in this screen is discussed 
following Figure 6. 
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Figure 6 

Local Data Input Screen


LOCAL DATA 

Baseline (Existing) 
Use Data 

Default Local Default 

Work-Trip Mode Shares Supply Final Mode Shares? 
Auto - Drive Alone

Auto - Carpool

Vanpool

Transit

Bicycle

Walk

Other

Total


78.2% 
12.1% 

0.5% 
4.9% 
0.4% 
3.0% 
0.8% 

0.0% 100.0% 

Work Trip Length (mi) 
Average person-trip length 
Average trip length -- vanpool 
Average trip length -- bicycle 
Average trip length -- walk 

12.2 
20.4 
2.9 
0.9 

Vehicle Occupancy 
Average Carpool Occupancy

Average Vanpool Occupancy


Length of Peak Period (hours) 
Percent of Work Trips in Peak Periods 

2.3 
7.2 

3.0 
61.4% 

Baseline mode share, trip length, average occupancy and peak period data representing local conditions are entered in this 
input screen.  From these inputs and data entered in the "Mode Choice Model Coefficients" screen, the COMMUTER model 
internally calculates final mode shares and travel changes resulting from TCM programs selected.  If you want to supply your 
own estimates of final mode shares (such as might be obtained from employee survey data), mark the box labeled "Supply Final 
Mode Shares" (with an "X").  When this option is selected, the COMMUTER model displays an additional series of input cells 
below the box where final mode share inputs can be entered.  Remember, these final mode shares should reflect work-trip 
mode choice after implementation of the TCM programs you’re currently analyzing and override the mode share calculations 
made by the model. 

The peak period includes the morning and evening time periods when highways are most congested. These periods may be 
defined differently in different areas.  For the default "percent of work trips in peak period" provided, the AM peak is defined as 
6:00 to 9:00 AM and the PM peak as 4:00 to 7:00 PM. The same peak period should be used for reporting percent of work trips 
in peak period and affected vehicle speeds (which are entered later in the "Other Emissions-Related Data" screen). 

"Length of peak period" refers to the length (in hours) of the AM or PM peak period. If the AM and PM peak periods are different 
lengths, this can be an average of the two lengths. 

"Percent of work trips in peak period" should also be reported as an average for the AM and PM peak periods combined. For 
example, assume there are 200,000 and 300,000 total vehicle trips in the AM and PM peak periods, respectively.  If the number 
of work trips are 150,000 in the AM peak and 250,000 in the PM peak, then the percentage of work trips in peak period is 
(150,000 + 250,000) / (200,000 + 300,000) = 80%. 

Existing Mode Shares, Trip Length, and Occupancy - If you are conducting a site-
specific analysis, you may be able to obtain data on existing employee mode shares from 
employee surveys, if such surveys have been conducted. You can also enter local data on 
trip lengths and average vehicle occupancy for carpools and vanpools if such data are 
available. 
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If you do not have specific data available, you should be able to obtain transportation data 
for the city, metropolitan area as a whole, or other area of analysis from the regional 
transportation planning agency. You should work with local or regional transportation 
planners to identify the most appropriate data for the analysis. 

If local data are not available, you may use the default parameters provided in the model. 
These are shown in Figure 6 under the “Defaults” column. You should indicate which 
default values to use by checking the appropriate box(es) on this screen. 

User-Supplied Final Mode Shares - If you are performing an analysis where you have 
estimates of “final” mode shares (after implementation of the TCMs being modeled), you 
can enter these final mode share estimates in the Local Data screen. Under most 
circumstances, you’ll want to let COMMUTER calculate final mode shares based on the 
inputs you supply in the TCM screens using the pivot-point methodology discussed in 
Section 1.5. There may be certain situations where you want to enter your own estimate 
of final mode shares, rather than using COMMUTER’s calculations. For example, when 
you are performing a site-specific analysis for a company, you may have employee 
survey data available that estimate how mode choice would change in response to a 
particular program or programs. 

For these situations, mark the “Supply Final Mode Shares?” box at the upper right of the 
Local Data input screen. When you do, a series of cells appears below this box, allowing 
you to enter final mode shares, reflecting changes from existing shares due to the TCM 
programs you’re modeling. 

For example, suppose under existing conditions that “Company A” work-trip mode 
shares were split at 80% Auto-Drive Alone and 20% Transit. Company A is considering 
a program in which employees are offered a cash incentive to ride the bus and, from an 
employee survey, determines that an additional 5% would accept the incentive and ride 
the bus. The final mode shares are thus split as 75% Auto-Drive Alone and 25% Transit. 
These values would be entered in the final mode share cells after you marked the “Supply 
Final Mode Shares?” box. 

NOTE: When you enter your own final mode shares in the Local 
Data input screen as explained above, any TCM programs that 
you’ve checked at the bottom of the Scenario Information screen 
and inputs you’ve entered in those TCM-specific screens are 
ignored. By entering your own final mode shares, you’re telling 
COMMUTER not to use the TCM inputs to calculate final mode 
shares. 
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Under most circumstances, you won’t know what the final mode shares will be as a result 
of the TCM programs that you are analyzing. In these cases, leave the “Supply Final 
Mode Shares?” box blank and allow COMMUTER to calculate final mode share from the 
TCM program inputs you’ll enter in subsequent input screens. 

Length of Peak Period - The “peak period” includes the morning and evening time 
periods when highways are most congested. These periods may be defined differently in 
different areas. You should use the same peak period definition when reporting the 
percent of work trips in a peak period that you use when reporting baseline travel speeds 
(see below). You can obtain information on the peak period definition from 
transportation planning staff at your regional transportation planning agency. 

“Length of peak period” refers to the length (in hours) of the AM or PM peak period. If 
the AM and PM peak periods are different lengths, you should use the average of the two. 

Percent of Work Trips in Peak Periods - You need to enter the percent of trips during 
the peak periods that are work-related, averaging the totals for the AM and PM peak 
periods combined. For example, assume there are 200,000 and 300,000 total vehicle trips 
in the AM and PM peak periods, respectively. If the number of work trips are 150,000 in 
the AM peak and 250,000 in the PM peak, then the percentage of work trips in the peak 
period is calculated as follows: 

150 000 + 250 000 , , 
= 80% 

200 000 + 300 000 , , 

You should enter local or site-specific data if it is available, instead of relying on the 
default value. The default value provided is based on the national percentage of all work 
trips that occur in both the AM and PM peak periods.  In this program, the default AM 
peak is defined as 6:00 to 9:00 AM and the default PM peak as 4:00 to 7:00 PM. 

3.3 Edit Coefficients 

This screen allows you to enter locally available values for mode-choice travel time and 
cost coefficients, rather than use the default values provided by the model. Figure 7 
illustrates the layout of the Edit Coefficients screen. 

Mode-choice coefficients are used within COMMUTER to compute changes in travel of 
each commute mode (e.g., drive-alone, carpool, transit, walk, etc.) under Site Access or 
Transit Improvement programs and Financial Incentive programs. These coefficients are 
used in transportation models referred to as “logit mode-choice” models to represent the 
willingness of commuters to use alternate modes of travel to driving alone when faced 
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with changes in travel time or cost. (Please refer to the accompanying COMMUTER 
Model Procedures Manual for detailed information on how mode-choice coefficients are 
developed, tested and applied in transportation modeling.) 

The travel and emission impacts calculated by COMMUTER are highly sensitive to the 
values of these coefficients, especially the cost coefficients. It is strongly recommended 
that you use local coefficients for mode choice, if available. Coefficients have been 
estimated in many urban areas by the regional transportation planning agency (usually 
MPOs, Councils of Government, or Associations of Governments). Values of travel time 
and cost coefficients for many individual cities are incorporated into COMMUTER at the 
bottom of this input screen. The values of these mode-choice coefficients are based on 
the travel models currently used by regional transportation planning agencies. You are 
encouraged to contact your local transportation planning agency to ensure the values cited 
are up-to-date or to obtain coefficients for cities not listed in the table at the bottom of the 
input screen. 

If local mode choice model coefficients are not available for your city, you can use the 
default values provided by the model (which are based on the “Metropolitan Area Size” 
you specified in the Scenario Information screen; see Section 3.1). However, these 
defaults will not represent mode choice behavior as accurately as actual local data. 
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Figure 7

Edit Coefficients Input Screen


MODE CHOICE MODEL COEFFICIENTS 

DEFAULTS BY AREA SIZE IVTT (min) OVTT (min) Cost (cents) 

C
h

ec
k

All Modes Walk Time 
Transit -- 

Wait 
Auto ­

Parking 
Transit ­

Fare 

All Areas -0.0253 -0.0473 -0.0466 -0.0056 -0.0040 

User-Specified 

Coefficients Used: Boston -0.0314 -0.0330 -0.0550 -0.0173 -0.0083 

Mode choice model coefficients are entered in this screen.  The program retrieves default coefficients based on national 
average from numerous cities’ models.  However, these defaults are typically not as accurate as city-specific coefficients 
developed for many communities across the country. City-specific coefficients for a number of cities based on a review of 
current literature and existing travel demand models are provided for use within the model and can be viewed by scrolling down 
below this help box.  The user is encouraged to utilize these local coefficients for the specific city being modeled (if available) in 
lieu of the defaults by simply checking the box next to the appropriate city.  The user is also encouraged to contact their local 
transportation planning agency to ensure the values cited are up-to-date or to obtain coefficients for cities not listed in these 
tables. 

When applying user-specified values, be aware that most models generally use input travel/wait time coefficients in MINUTES 
and cost-related coefficients in CENTS.  Mode choice models such as the TDM model then internally convert the values of 
these coefficients to match the units of the travel/wait time or cost inputs.  The COMMUTER model has also been programmed 
to apply a conversion factor to the Auto Parking and Transit Fare cost coefficients (in cents) when used with financial incentive 
inputs in units of DOLLARS per vehicle per day.  When inputting your own coefficients, make sure the travel/wait time 
coefficients are in MINUTES and the cost-related coefficients are in CENTS. 

Note to previous COMMUTER users:  In COMMUTER Version 2.0, metropolitan area size is no longer used to select the 
default mode choice coefficients.  A review of recently developed coefficients found that these coefficients do not show a  
significant variation by area size. 

CITY-SPECIFIC DEFAULTS IVTT OVTT Cost 

C
h

ec
k

City Year All Modes Walk Time 
Transit -- 

Wait 
Auto ­

Parking 
Transit ­

Fare 
Albuquerque 1992 -0.0209 -0.0219 -0.0978 -0.0031 -0.0031 
Atlanta 2002 -0.0256 -0.0639 -0.0256 -0.0031 -0.0013 
Baltimore 1993 -0.0300 -0.0750 -0.0750 -0.0043 -0.0043 
Boston 1991 -0.0314 -0.0330 -0.0550 -0.0173 -0.0083 
Chicago 1990 -0.0282 -0.0440 -0.0960 -0.0021 -0.0008 
Cleveland 1994 -0.0178 -0.0444 -0.0378 -0.0034 -0.0024 
Columbus 1999 -0.0213 -0.0640 -0.0465 -0.0016 -0.0016 
Dallas 1996 -0.0544 -0.0640 -0.0640 -0.0056 -0.0055 
Denver 1997 -0.0180 -0.0540 -0.0180 -0.0014 -0.0012 
Detroit 1996 -0.0512 -0.0186 -0.0186 -0.0041 -0.0041 
Houston 1985 -0.0220 -0.0568 -0.0568 -0.0154 -0.0061 
Los Angeles 1996 -0.0450 -0.1073 -0.0423 -0.0025 -0.0025 
Milwaukee 1991 -0.0157 -0.0412 -0.0412 -0.0045 -0.0045 
New York 1996 -0.0113 -0.0380 -0.0554 -0.0004 -0.0004 
Philadelphia 1986 -0.0391 -0.0316 -0.0511 -0.0026 -0.0012 
Phoenix 1991 -0.0167 -0.0206 -0.0304 -0.0053 -0.0053 
Portland 1994 -0.0394 -0.0646 -0.0397 -0.0135 -0.0135 
Reno 1991 -0.0275 -0.0550 -0.0550 -0.0167 -0.0067 
Sacramento 2001 -0.0250 -0.0380 -0.0380 -0.0026 -0.0026 
San Diego 1995 -0.0250 -0.0500 -0.0250 -0.0069 -0.0026 
San Francisco 1990 -0.0333 -0.0931 -0.0523 -0.0021 -0.0021 
San Juan 1990 -0.0366 -0.0717 -0.0752 -0.0066 -0.0066 
Santa Cruz 1990 -0.0163 -0.0325 -0.0325 -0.0045 -0.0036 
Seattle 1990 -0.0176 -0.0206 -0.0155 -0.0024 -0.0024 
Tucson 2000 -0.0178 -0.0400 -0.0200 -0.0018 -0.0018 
Washington D.C. 1994 -0.0300 -0.0750 -0.0750 -0.0043 -0.0043 
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4. TCM-SPECIFIC DATA


This section discusses the input screens that are used to enter TCM-specific data for each 
of five different types of programs, with each program having its own input screen.  As 
explained in Section 2, programs can be analyzed individually or in combination.*  At this 
stage, you can edit any of the programs checked under “Programs Analyzed” on the 
“Scenario Information” screen.  (Remember, however, that if you did not select a 
program from the Scenario Information screen, you will not have access to the data entry 
screen for that program.) 

4.1 Site Access and Transit Service Improvement Programs 

This section describes the Site Access and Transit Service Improvement program inputs. 
Figure 8 shows the single input screen used for these programs. 

Site Access Improvements 

Site access improvements include such things as preferential parking policies for carpools 
and vanpools or improvements to the work site or area that make access to transit easier. 
For example, parking spaces in close proximity to both office building locations and 
transit station/transit center locations could be provided for ease of access and reduced 
travel times for carpool and vanpool vehicles.  These programs also include improved 
pedestrian and bicycle infrastructure at transit locations to encourage transit usage.  Along 
with preferential parking spaces, infrastructure improvements could include secure 
lockers and showers for pedestrians and bicyclists and improved access to transit facilities 
from the adjacent roadway system. 

Walk-Access Time - You will need to specify the change in “walk access time,” which is 
the time required to walk from the parking space or transit stop to the work site.  A 
decrease in walk access time for any particular travel mode is represented as a negative 
value. 

* As noted in Section 2, however, you will not obtain accurate results by analyzing individual measures and 
then summing the results. Measures that may be implemented together should be analyzed together. 
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Figure 8 

Site Access & Transit Improvements Input Screen


SITE ACCESS & TRANSIT SERVICE IMPROVEMENTS 

I. Site Access Improvements 

Change in 
Walk Access 

Mode: Time (min) 
Drive Alone 
Carpool 
Vanpool 
Transit 
Bicycle 
Pedestrian 

Employer Participation Rate: 

"Change in Walk Access Time" represents the difference in walking time associated with travel to or from the workplace 
as a result of worksite access changes.  Walking time includes the time taken to walk from a parking lot or a bus stop to 
the actual worksite. Walk access time can be affected through policies such as preferential parking for carpools and 
vanpools or through improvements to the worksite or area which make access to transit easier.  A decrease in walk 
access time for any particular mode should be entered as a negative value.  

"Employer participation rate" refers to the percent of employers in the analysis area implementing the walk access 
improvements.  (This option is not necessary for site-specific analysis because the "participation rate" is 100%.) 

II. Transit Service Improvements 

IIa. More Frequent Service 
Change in avg. headway (min) 
Employment Served (% of area) 

IIb. Faster Service 
Change in route travel time (min) 
Employment Served (% of area) 

Transit Operating Data 
Increase in daily VMT by Transit 
Vehicles 
Average speed of affected transit 
vehicles (mph) 
Default average speed 14.8 
Check here to use default transit 
speed 

"Change in average headway" refers to the average change in frequency of service for transit service to the employment 
center or analysis area.  An increase in service frequency is entered as a negative number.  For example, if peak period 
transit service frequency increases from 20-minute to 15-minute intervals, the change in average headway would be 
entered as "-5.0". 

"Change in route travel time" refers to the average change in total route travel time for all transit service to the area.  A 
decrease in travel time is entered as a negative number.  For example, if new express bus service decreases the overall 
route travel time by 5 minutes, this would be entered as "-5.0". 

"Employment served" refers to the percent of employment in the analysis area which is served by the improved transit 
service.  (This option is not available for site-specific analysis). 

"Increase in daily VMT by transit vehicles" refers to the additional transit vehicle-miles of travel as a result of the 
improved transit service.  Refer to Section 4.1 of the COMMUTER Model User Manual for guidance on how to calculate 
this parameter. 
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Employer Participation Rate - If you specified an area-wide analysis scope, you will 
also need to specify the percent of employers in the analysis area implementing the walk-
access improvements. 

Remember, as discussed in Section 3.1, that there are two types of participation rates you 
need to consider in setting up the inputs to COMMUTER. The first type is used in 
estimating the affected employment inputs and refers to participation in any of the TCM 
programs being modeled. The second type, the individual program participation rates, 
are actual model inputs, and are used to further restrict the “eligibility” of all affected 
employment to individual programs, such as Site Access Improvement programs. Thus, 
in an area-wide analysis assuming 100,000 affected employees, a 15% Employer 
Participation Rate for Site Access Improvement programs instructs COMMUTER that 
15,000 employees (100,000 × 15%) are eligible or affected by site access improvement 
strategies. (Note that the model assumes a proportional ratio of employers to employees 
in determining affected employment for individual programs.) 

The employer participation rate is not used in site-specific analysis because it is assumed 
to be 100%. 

Transit Service Improvements 

Transit service improvements may include providing more frequent bus or shuttle service 
to work sites, as well as providing faster transit service through express routes or 
operational improvements. These improvements may also include implementing new 
route services resulting from the transit planning process. 

If you are analyzing improvements that lead to more frequent service, you will need to 
enter the “Change in Average Headway.” This refers to the average change in the 
frequency of transit service to the employment center or analysis area. An increase in 
service frequency is entered as a negative number. For example, if peak period transit 
service frequency increases from every 20 minutes to every 15 minutes, the change in 
average headway would be represented as -5.0 minutes. 

“Employment Served” refers to the percent of employment in the analysis area that is 
served by the improved transit service. As with the Employment Participation Rate input 
for Site Access Improvement programs, Employment Served should reflect the fraction of 
all affected employment that are exposed to the transit improvements. As an example, 
expanding transit service along a single network corridor would affect only the fraction of 
employment served by this transit corridor. Again, you do not need to enter this input if 
you are conducting a site-specific analysis. 
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If you are evaluating faster service improvements, you will need to enter the “Change in 
Route Travel Time.” This refers to the average change in the time required to travel the 
total route for all transit service to the area. A decrease in travel time is represented as a 
negative number. For example, if new express bus service decreases the overall route 
travel time by 5 minutes, this would be represented as -5.0 minutes. 

If transit service improvements are implemented, the change in daily transit vehicle-
miles as a result of increased service must also be considered. For this, you will need to 
estimate the following items: 

�	 The number of additional daily bus-trips on each route, for routes on which 
service is increased; and 

�	 The total round-trip route length for each route on which service is increased. 

You should be able to obtain information on route-mileage increases from the local 
transit agency or you can develop estimates from operating plans for the proposed transit 
service. Estimates of daily mileage increases should take into consideration the distance 
traveled to and from the storage/maintenance facility to the beginning/end of the route. 

In addition, an average travel speed for the affected transit service should be estimated. 
This can be done by dividing the total length of each affected route by the time taken to 
complete the route. 

If transit service improvements are implemented, the change in daily transit vehicle-miles 
as a result of increased service must also be considered. This requires estimating the 
following items: 

�	 The number of additional daily bus-trips on each route, for routes on which 
service is increased; and 

�	 The total round-trip route length for each route on which service is increased. 

Information on route-mileage increases can be obtained from the local transit agency or 
can be estimated from operating plans for the proposed transit service. Estimates of daily 
mileage increases should take into consideration the distance traveled to and from the 
storage/maintenance facility to the beginning/end of the route. 

In addition, an average travel speed for the affected transit service should be estimated. 
This can be done by dividing the total length of each affected route by the time taken to 
complete the route. 
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4.2 Financial Incentive and Parking Cost Programs 

Financial incentives include any policies that affect how much it costs to travel via a 
particular mode. Some examples of financial incentives are listed below. 

� Increased parking charges, especially for single-occupant vehicles. 

� Reduced parking fees for carpools and vanpools. 
� Transit subsidies such as free monthly passes. 

� Parking cash-out programs. 

The Financial Incentive and Parking Cost program input screen is shown in Figure 9. A 
decrease in cost (i.e., an incentive) is entered as a negative number. Changes in parking 
cost are entered on a per-vehicle basis. Changes in other fare costs and other financial 
costs are entered based on the change in cost per person per day (i.e., round trip transit 
fare). 

Figure 9

Financial Incentives Input Screen


FINANCIAL INCENTIVES AND PARKING COSTS 

Change In Daily Cost: 
Other 

Financial Total Change 
Parking Cost Fare Cost ($/ Cost ($/ ($/ 

Mode: ($/vehicle) person/RT) person/RT) person/RT) 
Drive Alone $ -
Carpool $ -
Vanpool $ -
Transit $ -
Bicycle $ -
Pedestrian $ -

Employer 
Participation Rate: 

"Financial incentives and parking costs" may include higher parking charges for single-occupant vehicles, reduced 
parking fees for carpools or vanpools, transit subsidies such as free monthly passes, or other financial incentives for 
specific modes.  A decrease in cost is entered as a negative number. For example, provision of a transit pass valued 
at $30 a month would be entered as a change in fare cost of -$1.50 ($30 / 20 days). The cost change inputs are 
entered on a daily basis. 

"Employer participation rate" refers to the percent of employers in the analysis area offering these incentives to their 
employees.  (This option is not required for site-specific analysis because the "participation rate" is 100%.) 
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As in other screens, “Employer Participation Rate” refers to the fraction of all affected 
employees being offered financial incentives on a percent-of-employers basis. Like the 
other program-specific “employer participation rate” inputs, COMMUTER applies the 
proportion of participating employers to determine the fraction of all affected employees 
being offered financial incentives. It is not used for site-specific analysis. 

Two examples are provided below to illustrate how the financial costs should be 
calculated and entered. 

Sample Calculations for Financial Incentives and Parking Cost Programs: 

�	 If parking costs are increased by $2.00 per day for all types of vehicles, you 
would enter +$2.00 for Auto-Drive Alone, Carpool, and Vanpool.  (The model 
will convert the costs per vehicle to the costs per person by dividing by the 
assumed average vehicle occupancy as identified in “Local Data.”) 

�	 If a transit pass worth $30 per month is provided, you would enter a change in 
fare cost of -$1.50 ($30 divided by 20 days per month). 

Note that you enter these cost inputs in dollars per vehicle per day.  COMMUTER 
internally converts the Parking Cost and Transit Fare mode-choice coefficients that you 
entered in units of cents in the “Edit Coefficients” screen into dollar units before 
combining them with the cost inputs entered in this screen in the mode share calculations. 

Parking Cash-Out Programs - Parking cash-out programs are modeled in this input screen 
by treating the cash-out payment as a “subsidy” for use of eligible alternative modes.  For 
example, if the cash value of the parking subsidy were $60 per month or $2 per day, a 
current Single Occupant Vehicle (SOV) user would see no difference in his/her cost to 
drive (park), but the transit user would suddenly find it $2 per day cheaper to use transit. 
The same logic applies to all modes that are eligible alternatives, i.e., bike, walk, or 
ridesharing (if there is no problem with the cash-out recipient still parking at the site as a 
carpooler/vanpooler). In this example, you would enter -$2 in the “Transit” row and 
“Parking Cost” column. 

So to handle cash-out programs in COMMUTER, you enter nothing for the SOV mode 
parking cost, and enter a subsidy for each of the eligible alternative modes.  Note that in 
the rideshare case, each passenger receives the full value of the subsidy, unlike where you 
give a parking discount to carpools and the savings is split among the number of 
occupants. 
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4.3 Site-Specific Employer Support Programs 

There are a number of strategies that employers can use that reduce the number of people 
commuting to work in single-occupancy vehicles (SOVs), but do not result in measurable 
changes in the time or cost of traveling to work. Research suggests that such “soft” 
incentives or support programs can change travel behavior by providing encouragement 
to use other modes of travel, informing travelers of alternatives, or removing 
impediments. Examples of this type of strategy include selling transit passes at the work 
site, providing rideshare matches, marketing and promoting alternative modes, providing 
a guaranteed ride home program, forming and supporting a vanpool, and providing 
preferential parking for carpools. (Note that these types of programs also apply for an 
area-wide analysis, discussed in Section 4.4.) 

Figure 10 shows the input screen for site-specific analysis of employer support programs. 
As shown in the figure, the first thing you need to do is specify the entry format, which 
refers to the type of data you will be entering. 

For a site-based analysis, it is recommended that you specify existing and proposed 
program levels. These refer to the general level of effort spent on the program (which 
affects its effectiveness) and are explained below, along with the codes used for data 
entry. They are defined separately for carpooling, vanpooling, transit, and bicycle 
commuting. 

As an alternative, you can specify the expected mode share increase. This expected 
increase in each mode of travel is added to the baseline mode share that was specified in 
the input data. 

CAUTION: You should not use this alternative entry option unless 
you have good data indicating that a proposed program will lead 
to a likely mode share increase.  If you do specify a mode share 
increase, you should document existing support programs and the 
programs to be implemented, along with survey or other data that 
were used to estimate the mode share increase. 
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Figure 10 

Site-Specific Employer Support Programs Input Screen


EMPLOYER SUPPORT PROGRAMS FOR ALTERNATIVE MODES

SITE-SPECIFIC ANALYSIS


Entry Format (check one only): 
Specify Program Level 
Specify Mode Share Increase 

Specify Program Level: 

"Program Level" and "Mode Share Increase" input options are mutually 
exclusive. You enter input data for either one or the other based on which 
Entry Format box you check to the left. See the help box below for an 
explanation of each input. 

Program Existing New 
Carpool 
Vanpool 
Transit 
Bicycle 

Specify Mode Share Increase: 

Program Existing Increase New 
Carpool 0.0% 0.0% 
Vanpool 0.0% 0.0% 
Transit 0.0% 0.0% 
Bicycle 0.0% 0.0% 

"Employer Support Programs" include programs such as provision for an on-site transportation coordinator, ridematching, 
transit information, and other actions aside from time and cost incentives which encourage employees to utilize alternative 
modes. Two entry options are available for site-specific analysis: 

(1) Specify existing and new program levels for Carpool, Vanpool, Transit, and Bicycle program support.  A program level 
of "0" represents no program. Program levels of "1" through "4" indicate varying levels of effort for the programs. These 
program levels are described in Section 4.3 of the COMMUTER Model User Manual. 

(2) Specify an expected mode share increase for each mode. This increase is added to the baseline mode share as 
specified in the input data. 

IMPORTANT: Entry option (2) should only be utilized if the user has evidence, such as survey data, suggesting a likely 
mode share increase as a result of proposed programs.  If a mode share increase is specified, the user should document 
existing support programs and programs to be implemented, along with survey or other data indicating the basis for the 
mode share increase estimates. 

Definition of Program Levels 

The impact of employer support programs and strategies varies depending on the level of 
effort expended on the program. The level of program effort is a particularly important 
data input because it defines what is actually meant by, for example, a “carpool support” 
program. The program level can vary from 0 to 4, with 0 representing no program and 4 
representing a program of maximum effort. (These program level definitions will also 
apply for area-wide analyses, as discussed in Section 4.4.) The following program level 
descriptions are not requirements for each level, but are intended as suggested guidelines 
to help you assign a level designation to the support activities you are trying to model. 
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Note that preferential parking or direct financial incentives to employees offered as part 
of a support program should be captured on the Site Access and Transit Service 
Improvement input screen, and the Financial Incentives and Parking Costs input screen, 
respectively. They should not be considered in the determination of program support 
level. 

Carpool Support Programs 

Level 0 - no program 

Level 1 - includes carpool information activities (tied in with area-wide matching) 
and a quarter-time transportation coordinator. 

Level 2 - includes an in-house carpool matching service and/or personalized 
carpool candidate get-togethers (including information activities) and a quarter-
time transportation coordinator. 

Level 3 - includes in-house carpool matching and information services plus 
preferential (reserved, inside, and/or especially convenient) parking for carpools, a 
policy of flexible work schedules* to accommodate carpools, and a half-time 
transportation coordinator. 

Level 4 - includes in-house carpool matching and information services plus 
preferential parking for carpools, flexible work schedules, and a full-time 
transportation coordinator. 

Vanpool Support Programs 

Level 0 - no program 

Level 1 - includes vanpool information activities (tied in with area-wide vanpool 
matching and/or third-part vanpool programs), plus a quarter-time 
transportation coordinator. 

Level 2 - includes in-house vanpool matching services and/or personalized vanpool 
candidate get-togethers, and non-monetary vanpool development, plus a 
quarter-time transportation coordinator and a policy of flexible work 
schedules. 

* Flexible work schedules as defined under these support programs refers to providing latitude to employees 
to accommodate slight variations in arrival/departure to participate in these programs. This differs from a 
formal Flex-Time policy, which is defined and discussed later in Section 4.5. 
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Level 3 - includes in-house vanpool matching services; vanpool development and 
operating assistance, including financial assistance, such as vanpool 
purchase loan guarantees, consolidated purchase of insurance, and a 
startup subsidy (generally, at least two forms of such financial assistance 
should be included); and additional services such as van washing and 
preferential (reserved, inside, and/or especially convenient) parking for 
vanpools, plus a half-time transportation coordinator. 

Level 4 - includes in-house vanpool matching services; vanpool development and 
operating assistance, including major financial assistance, such as 
employer purchase of vans with favorable leaseback (or alternative 
continuing subsidy, such as free maintenance, free insurance, and/or 
direct subsidy to keep vanpool fares low) in addition to startup subsidy; 
several additional incentives such as van washing, preferential parking for 
vanpools, guaranteed ride home, and a full-time transportation 
coordinator and/or personalized vanpool candidate get-togethers. 

Transit Support Programs 

Level 0 - no program 

Level 1 - includes a transit information center plus a quarter-time transportation 
coordinator. 

Level 2 - includes a transit information center and a policy of work hours 
flexibility to accommodate transit schedules/delays, plus a quarter-time 
transportation coordinator. 

Level 3 - includes a transit information center and a policy of work hours 
flexibility, on-site transit pass sales, plus a half-time transportation 
coordinator. 

Level 4 - includes a transit information center and a policy of work hours 
flexibility, on-site transit pass sales, guaranteed ride home, and a 
full-time transportation coordinator. 

Bicycle Support Programs 

Level 0 - no program 

Level 1 - providing on-site bicycle parking (racks or lockers). 
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Level 2 - providing bicycle parking (racks or lockers) and shower facilities. 

Level 3 - providing secure bicycle parking (storage lockers or indoor storage) and 
shower facilities, in conjunction with local infrastructure conducive to 
bicycling. This includes the presence of (a) off-street bike paths, (b) on-
street bike lanes, and/or (c) local streets with light traffic by which 
cyclists can access the workplace. 

Level 4 - providing parking, shower, and infrastructure conditions as for Level 3, 
and also sponsoring workplace promotional activities. These activities 
should include promoting bicycle commuting, identifying the availability 
and location of parking and shower facilities, and providing local bicycle 
route maps, along with other activities to encourage bicycle commuting. 

Some employer support programs may have combinations of characteristics different than 
those shown here. In this case, you should choose the program level that most closely 
represents the actual program being implemented. 

If there is no program level that you feel most closely represents the combination 
program being offered, you can specify “combinations” of program levels by running the 
program for an area-wide rather than site-specific analysis. For example, if a carpool 
program includes all the elements of a Level 3 program except for flexible work 
schedules, you may want to model this program as halfway between Level 2 and Level 3 
in terms of effectiveness. You can do this by setting the analysis scope to “Area-Wide” 
and specifying that 50 percent of employers have a Level 2 program and 50 percent have 
a Level 3 program. Note that if you set the employer participation rate at 100 percent for 
every program being tested, the area-wide and site-specific analyses will give identical 
results. 

4.4 Area-Wide Employer Support Programs 

The discussion in Section 4.3 of the types of employer support programs that may be 
offered also applies here.  Although different input formats are used for site-specific and 
area-wide employer support programs, the data elements themselves are similar. 
Figure 11 shows the input screen for area-wide analysis of employer support programs. 
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Figure 11

Area-Wide Employer Support Programs Input Screen

EMPLOYER SUPPORT PROGRAMS FOR ALTERNATIVE MODES 

AREA-WIDE ANALYSIS 

Percent of Employers Participating -- Existing 
Program Level 

Program None 1 2 3 4 Total 
Carpool 100% 100% 
Vanpool 100% 100% 
Transit 100% 100% 
Bicycle 100% 100% 

Percent of Employers Participating -- New 
Program Level 

Program None 1 2 3 4 Total 
Carpool 100% 100% 
Vanpool 100% 100% 
Transit 100% 100% 
Bicycle 100% 100% 

"Employer Support Programs" include programs such as provision of an on-site transportation coordinator, 
ridematching, transit information, and other actions aside from time and cost incentives which encourage employees to 
utilize alternative modes. 

For an area-wide analysis, the analyst should specify both existing and new (expected) participation rates (percent of 
employers participating) by program level for each mode.  Program levels of "1" through "4" indicate varying levels of 
effort for the programs which are described in Section 4.4 of the COMMUTER Model User Manual. 

You should use the definitions of support program levels given in Section 4.3 for area-
wide analyses also. Be sure to read these definitions before proceeding. 

For area-wide analysis of employer support programs, you must specify the percent of 
employers participating in each of the program levels and modes. For each mode 
(carpool, vanpool, transit, and bicycle), you need to enter the percent of employers in the 
area participating at each program level. The sum of Levels 0 through 4 for each mode 
should equal 100%. Employers who are not participating in any program would be 
included in the “Level 0” program level. Participation rates should be specified for both 
the base case (existing conditions) and the proposed program levels being evaluated. 

4.5 Alternative Work Schedule Programs 

This class of commuter-related TCM strategies is aimed at reducing how often commute 
trips are made or shifting the timing of the trip out of the peak hour. For example, flex­
time and staggered work hour strategies have the effect of merely shifting commute travel 
to a less-congested time period. These strategies will not affect the number of overall 
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trips or the amount of VMT, but they will change the distribution of trips, VMT, and 
emissions between the peak and off-peak time periods. They may also affect overall 
emissions slightly by affecting the average speed in the peak and off-peak periods. 
Definitions of the various work schedule programs and their likely impacts are discussed 
later in this section. 

Figure 12 shows the input screen for entering information on alternative work schedules 
and telecommuting programs. As shown, you will first need to choose an entry format 
option, as explained below: 

�	 Eligibility Rate - This indicates the percent of all employees in the analysis 
system* who are offered the program. The model then applies an assumed 
participation rate to the total number of employees that are eligible. Note that the 
employees eligible for each alternative work schedule and those not eligible for 
any strategy must sum to 100 percent.  In other words, only one alternative work 
schedule strategy may be offered to an employee at a time. This simplifying 
assumption is used in the manual and spreadsheet model because employees are 
unlikely to combine more than one alternative work strategy at a time (for 
example, those employees working a compressed work week are unlikely to be 
allowed to telecommute on regularly scheduled work days). This parameter 
relates mainly to the logic of applying this strategy to different employment 
segments. For example, manufacturing or retail employees are not reasonable 
candidates for participation in telecommuting programs. You should consider the 
characteristics of the employment base you are analyzing when determining the 
value to use for this parameter. 

�	 Participation Rate - As an alternative, you can specify existing and expected 
actual participation rates for each program. If you do specify the participation 
rates, you should document the existing support programs and the programs to be 
implemented, along with the survey or other data that formed the basis for the 
participation rate estimates. 

Alternative Work Schedules are more commonly implemented by employers as an 
employee benefit or workplace efficiency measure, rather than as a mode shift strategy. 
As such, the proportion of employees that might adopt these schedules is highly 
dependent on how and why the employer is implementing the program. The default 
proportions using the "eligibility rate" option are currently set to 22 percent for Flexible 
Work Hours, Staggered Work Hours, and 4/40 Compressed Work Weeks, and to 11 
percent for 9/80 Compressed Work Weeks. These figures reflect voluntary adoption of 
alternative work schedules if made available and optional. The user can change the 

*  For an area-wide analysis, this will be the percent in the area-wide employment base; for a site-
specific (single employer) analysis, it will be the percent of employees within the firm. 
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proportion of employees who would shift to each schedule to reflect local knowledge of 
such programs. For example, if a given employer or set of employers decides to require 
staggered hours to addressed localized congestion or compressed work weeks to reduce 
overall operating costs, the proportion of employees shifting schedules could be 
considerably higher. 

Figure 12 

Alternative Work Schedules Input Screen


ALTERNATIVE WORK SCHEDULES 

Use Data 
Default Local Default 

Alternative Work Schedule Parameters 
Telecommute: Avg. Days/Week 

Flex Time/Staggered Hours:  Percent of trips

shifted from peak period


Participation Entry Format (check one only): 
Specify Eligibility for Participation 
Specify Before/After Participation Rates 

A. Eligibility for Participation 

1.5 

% Eligible 
Program Existing New 
Flex Time 
Compressed 4/40 
Compressed 9/80 
Staggered Hours 
Telecommute 
Not Eligible 100% 100% 
Total 100% 100% 

B. Participation Rates 

% Participating 
Program Existing New 
Flex Time 
Compressed 4/40 
Compressed 9/80 
Staggered Hours 
Telecommute 
Not Participating 100% 100% 
Total 100% 100% 

"Alternative Work Schedules" include the option to allow employees to utilize flex time, compressed work weeks, staggered work hours, or 
telecommuting.  Flex time and staggered hours will have the effect of shifting some trips outside of the peak period, while compressed 
work weeks and telecommuting will have the effect of eliminating some work trips.  Two program entry options are available: 

(1) The user can specify the percentage of employees eligible for each program. Both existing and new levels of eligibility should be 
specified. 

(2) The user can specify existing and expected participation rates for each program. 

To accomodate instances where employees are eligible for, or participate in multiple programs, the model allows the user to enter rates 
that exceed 100% when summed across all alternative programs.  The model then internally normalizes the rates before using them in 
the travel calculations.  Section 4.5 of the COMMUTER Model User Manual presents an example for this situtation. 

IMPORTANT:  Entry option (2) is preferred if the user can obtain data indicating a likely participation rate as a result of proposed 
programs. If participation rates are specified, the employer/analyst should document existing support programs and programs to be 
implemented, along with survey or other data indicating the basis for the participation rate estimates. If the user does not have survey 
data indicating likely participation rates or another strong basis for estimating expected local participation rates, entry option (1) should be 
used. 
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Definition of Alternative Work Schedule Strategies 

Flex-Time - In this policy, employees can adjust their work schedule (based on when they 
arrive at and depart from the work site) in order to travel during the off-peak hours, when 
there should be less traffic congestion. COMMUTER assumes a formal Flex-Time 
policy rather than flexible work schedules. Flexible work schedules are seen as simply 
allowing employees who would carpool or take transit to arrive or leave with slight 
variations in order to be compatible with the pool/bus schedule. In contrast, a Flex-Time 
policy involves formally moving the time of arrival or departure to a set of consistent 
work hours that are different from the employer’s official hours. This type of policy may 
actually detract from employees’ incentive to carpool or take transit as a means of 
avoiding traffic congestion. The only assumed effect of this strategy is to shift the time 
of the trips, no vehicle trips are eliminated. 

Staggered Work Hours - Under this strategy, employers establish different starting times 
for groups of employees in order to avoid having the entire workforce arrive or leave at 
the same time. Some work sites have a large number of employees arriving within a very 
narrow time period, so staggering starting hours can help reduce localized traffic 
problems. This strategy is also assumed to affect only the timing of the trips, not the 
number of vehicle trips. 

Compressed Work Week - Under this strategy, employees are allowed to reduce the 
number of work trips made by working longer hours on fewer days per week. Options 
include the 4/40 schedule where 40 hours are worked in 4 days with the fifth day off and 
the 9/80 schedule where 80 hours are worked in 9 days with the tenth day off. 
COMMUTER assumes that the 4/40 schedule eliminates one round-trip a week (1/5 of a 
daily trip) and that the 9/80 schedule eliminates one round-trip every two weeks (1/10 of 
a daily trip) for each participating employee. 

Telecommuting - This strategy involves allowing employees to work off-site, usually at 
home via telecommunications linkups, one or more days per week. Telecommuting thus 
reduces the demand for travel to the workplace. This is accounted for in COMMUTER 
by simply removing person trips, along with the equivalent number of vehicle trips, from 
the total amount of travel. (A more sophisticated analysis would consider how some of 
the commute trips might be replaced by non-work travel.) 
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5. EMISSIONS-RELATED INPUT SCREENS


In the final two input screens, you will supply the information that COMMUTER needs 
to calculate emission reductions. (If you are only interested in using COMMUTER to 
compute travel impacts, you don’t need to enter any input information these two screens.) 

To make this easier, a large matrix of MOBILE6.2 emission factors was generated for a 
series of local conditions and provided with the program.  (A total of 192 different sets of 
emission factors are provided with COMMUTER.)  To use these factors, all that you need 
to do is supply a simple set of vehicle fleet characteristics, and COMMUTER will then 
look up the appropriate set of MOBILE6.2 factors and use them to calculate emission 
reductions from the TCM programs being evaluated.  Thus, you do not have to supply 
detailed, locally generated MOBILE6.2 emission factors. 

If you are an experienced MOBILE6.2 user, however, and want to use emission factors 
that exactly match your local conditions, you can optionally direct COMMUTER to 
import and apply your locally generated factors. (Refer to Section 2.7 for step-by-step 
details on generating and properly importing your own MOBILE6.2 emission factors into 
COMMUTER.) 

5.1 Fleet Emissions Information 

In the first emissions-related input screen, you will provide the data needed for the 
program to select the appropriate set of pre-loaded MOBILE6.2 emission factors or 
activate the User-Supplied Emission Factors” option if you want to use your own locally 
generated MOBILE6.2 factors. 

Figure 13 shows the layout of this screen. If you want to use the pre-loaded emission 
factors contained in COMMUTER, follow the input requirements under “Using Pre-
Loaded Factors.” To use your own factors, see “Using Locally Generated Factors.” 

Using Pre-Loaded Factors - To use pre-loaded factors, you must select from the available 
fleet characteristic options in the MOBILE Scenario section at the top of the screen that 
best match your local conditions. Once you've specified all of the fleet characteristics or 
changed any of these characteristics, you will be reminded to import the scenario-specific 
emission factors using the "Import Default Emission Factors" command on the "File" 
menu. You do not need to re-import the default emission factors if you only change the 
calendar year of analysis, as each default emission factor file contains factors for all six 
calendar years available. (Leave the “User-Supplied Emission Factors” and “Calendar 
Year of User EFs” cells toward the bottom of the screen blank.) 
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Figure 13a 

Fleet Emissions Information Input Screen (p. 1)


FLEET EMISSIONS INFORMATION 

Field Data Notes 

MOBILE Scenario Inputs 
Enter either 2007, 2009, 2010, 2013, 2019, or 2021 
S = Summer, W = Winter 
1 = Mild, 2 = Moderate, 3 = Severe 
0 (zero) = none, 1 = Basic I/M, 2 = Enhanced I/M, 3 = OBD Only 
C = Conventional, R = RFG 
1, 2, 3, 4, or 5 (based on state - see below) 

Calendar Year of Analysis 
Season 
Climate Type 
I/M Program Type 
Fuel Type 
PADD 

The "MOBILE Scenario" inputs are used by the program to select a specific set of MOBILE6.2 emission factors from a series of 
stored tables that best represent local conditions and emission control programs being modeled. These inputs are familiar to 
MOBILE6.2 users. Further clarification of these inputs for users less familiar with the MOBILE6.2 emission factor model is 
provided below. Once the user has entered all scenario inputs, or changed an input, he or she must import the scenario 
emission factors using the "Import Default Emission Factors" command from the File menu. 
Calendar Year - Because new vehicle emission levels continue to decrease with the introduction of each model year, current and 
future vehicle fleet emissions will depend on the calendar year being analyzed. 
Season - This input affects the temperature range for which emissions are modeled (emissions characteristics of vehicles vary 
depending upon the temperature range in which the vehicle is being operated.)  The choice of season may depend upon which 
pollutants are of greatest interest.  Since ozone is typically a summer problem and carbon monoxide (CO) is typically a winter 
problem, summer should generally be used if ozone is of primary interest, while winter should be used if reducing CO is of 
primary interest.  The seasonal importance of other pollutants may vary regionally. 
Climate Type - This input is used on conjunction with the "season" input to determine default temperature ranges for the model. 
Choose the climate type (1 = mild, 2 = moderate, 3 = severe) that most closely matches the average daily minimum and 
maximum temperatures in your area (in deg F) as specified below:

 Summer - Mild:  min 55/max 75

 Summer - Moderate: min 65/max 85

 Summer - Severe: min 75/max 95

 Winter - Mild: min 52/max 72

 Winter - Moderate: min 32/max 52

 Winter - Severe:  min 12/max 32


If the user is interested, monthly normal temperatures for 250 cities can be looked up through the National Climatic Data Center,

http://www.ncdc.noaa.gov/oa/ncdc.html. 

I/M Program Type - The type of Inspection and Maintenance (I/M) program, if any, being operated. Basic I/M refers to a program

where a simple "no-load" idle or 2500 RPM test is performed.  Enhanced I/M represents programs in which a loaded IM240 or 

ASM test are run on a dynamometer.  OBD Only represents programs in which vehicles are not subject to an annual or biennial

inspection. but instead emissions malfunctions are identified by a vehicle’s on-board diagnostics (OBD) system.

Fuel Type - Under the 1990 amendments to the Clean Air Act, certain areas of the country must use reformulated gasoline (RFG) 

beginning in 1995. This input allows the user to specify whether RFG is being used. A map and list of counties in which RFG is 

required is provided on the EPA’s web site, http://www.epa.gov/OMSWWW/rfg/whereyoulive.htm.

PADD - (Petroleum Administration for Defense District) - PADD's were delineated during World War II to facilitate oil allocation.

The characteristics of refined fuels, and therefore the emissions characteristics of vehicles, vary generally by PADD.  The most 

significant effect is on emissions of air toxics. Select the appropriate PADD (1 – 5) based on your analysis state:


 1 - East Coast: Connecticut, Delaware, District of Columbia, Florida, Georgia, Maine, Maryland, Massachusetts, New 
Hampshire, New Jersey, New York, North Carolina, Pennsylvania, Rhode Island, South Carolina, Vermont, Virginia, West 
Virginia. 

2 - Midwest: Illinois, Indiana, Iowa, Kansas, Kentucky, Michigan, Minnesota, Missouri, Nebraska, North Dakota, South Dakota, 
Ohio, Oklahoma, Tennessee, Wisconsin.

 3 - Gulf Coast: Alabama, Arkansas, Louisiana, Mississippi, New Mexico, Texas. 
4 - Rocky Mountain:  Colorado, Idaho, Montana, Utah, Wyoming.
 5 - West Coast: Alaska, Arizona, California, Hawaii, Nevada, Oregon, Washington. 

For a map of PADDs, see: http://www.eia.doe.gov/pub/oil_gas/petroleum/analysis_publications/oil_market_basics/paddmap.htm. 
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Figure 13b 
Fleet Emissions Information Input Screen (p. 2) 

User-Supplied MOBILE Emission Factors
 Mark the box to the left (with an "X") to compute emission reductions 

User-Supplied Emission Factors  using alternate MOBILE6.2 emissions factors instead of the
 pre-loaded factors already contained in the COMMUTER model 

Calendar Year of User EFs  Select the calendar year of the user-supplied emission factors 

The COMMUTER model has been designed to use pre-loaded MOBILE6.2 emission factors for a defined range of input 

conditions or a set of user-supplied emission factors for specific local conditions.  Before user-supplied emission factors can be 

used, the user must load these factors into the model using a two-step process:

1) MOBILE6.2 database format output must be processed, using the "Process MOBILE Output" command from the File menu. 

This routine requests the user to select a MOBILE6.2 output file (.TB1), and then produces a text file with the extension ".TBZ,"

that is formatted for import into the COMMUTER Model.

2) The .TBZ data file must be imported, using the "Import User Emission Factors" command from the File menu.  The user can 

choose a different .TBZ file without having to process MOBILE output every time. 


The "Process MOBILE Output" command requires the availability of a MOBILE6.2 output file in database format (.TB1 file 

extension), along with corresponding toxics (.TOX) and particulate (.PM) output files that have the same base file name as the 

.TB1 file.  The resulting .TBZ file can be stored with the COMMUTER Model for future use, and the .TB1, .TOX, and .PM files 

deleted or moved if desired. The database output options must be specified as shown in the sample MOBILE6.2 input file 

provided and described in Section 5 of the User Manual.  The "Calendar Year of User EFs" input identifies the specific calendar

year factors from the set of user-supplied factors.  The calendar year can be any year between 1960 and 2050, but must match 

one of the available calendar years in the user-provided MOBILE6.2 output files.  (These output files may include a maximum of

six calendar year scenarios.)


Each of these “pre-loaded” fleet characteristics inputs is explained below. 

•	 Calendar Year - Since vehicle fleet emission levels change as new technology 
improvements are introduced on newer cars, the calendar year that represents the 
analysis scenario must be entered. 

You can choose either 2007, 2009, 2010, 2013, 2019, or 2021. If you are 
interested in an analysis year between two of those years, the model should be 
run for both of the surrounding years (for example, if you are interested in 2008, 
you should run analyses for both 2007 and 2009).  You will then need to 
interpolate the resulting travel and emission impacts to represent impacts in the 
year of interest. 

When you choose the year, you should keep in mind the time period when the 
TCM programs being modeled will actually be implemented. For example, in 
evaluating improved levels of transit service, it may take a couple of years to 
implement the service improvements. 

•	 Season - Vehicle emissions vary depending upon the ambient temperature and, 
in some areas, fuel controls are imposed only in certain seasons. You therefore 
need to enter the season for the analysis of interest, selecting either "S" (summer) 
or "W" (winter). If you are an air quality planner, you will generally select 
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summer when evaluating ozone-related emission reductions (including VOC and 
NOx), and winter for carbon monoxide evaluations. The seasonal importance of 
other pollutants may vary regionally. 

•	 Climate Type - This input is used in conjunction with the "season" input to 
determine temperature ranges for the model. You should choose the climate type 
(1 = mild, 2 = moderate, 3 = severe) that most closely matches the average daily 
minimum and maximum temperatures in your area (in degrees Fahrenheit), in 
either summer or winter depending upon your analysis season: 

- Summer - Mild (S, 1): min 55/max 75

- Summer - Moderate (S, 2): min 65/max 85

- Summer - Severe (S, 3): min 75/max 95

- Winter - Mild (W, 1): min 52/max 72

- Winter - Moderate (W, 2): min 32/max 52

- Winter - Severe (W, 3): min 12/max 32


You may, if you choose, look up monthly normal temperatures for your city 
through the National Climatic Data Center, 
http://www.ncdc.noaa.gov/oa/ncdc.html. Data for 250 cities are provided at no cost 
on this web site. In most areas, summer temperatures for July and winter 
temperatures for January (when temperatures are at their highest and lowest) should 
be used. 

•	 I/M Program Type - The type of Inspection and Maintenance (I/M) program, if 
any, being operated in your area will affect fleet emissions. If you do not know 
what type of I/M program is in place in your area, your state department of 
environmental protection or department of motor vehicles should be able to tell 
you. The following I/M program options are available: 

- None (0) - No I/M program exists in your area. 
- Basic I/M (1) - A program where a simple "no-load" idle or 2500 RPM test is 

performed along with a visual inspection; 
- Enhanced I/M (2) - A program in which a loaded IM240 or ASM test are run 

on a chassis dynamometer in conjunction with a visual and functional 
emission control system inspection; 

- OBD Only (3) - A program in which vehicles are not subject to an annual or 
biennial inspection, but instead emissions malfunctions are identified by a 
vehicle's on-board diagnostics (OBD) system. 

•	 Fuel Type - Under the 1990 amendments to the Clean Air Act, certain areas of 
the country must use reformulated gasoline (RFG) beginning in 1995. This input 
allows the user to specify whether RFG is being used. A map and list of counties 
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in which RFG is required is provided on the EPA’s web site, 
http://www.epa.gov/OMSWWW/rfg/whereyoulive.htm. 

•	 PADD - (Petroleum Administration for Defense District) - PADDs were 
delineated during World War II to facilitate oil allocation. The characteristics of 
refined fuels, and therefore the emissions characteristics of vehicles, vary 
generally by PADD. The most significant effect is on emissions of air toxics. 
Select the appropriate PADD (1 - 5) based on your analysis state:

    1 - East Coast:  Connecticut, Delaware, District of Columbia, Florida, Georgia, 
Maine, Maryland, Massachusetts, New Hampshire, New Jersey, New York, 
North Carolina, Pennsylvania, Rhode Island, South Carolina, Vermont, 
Virginia, West Virginia.

    2 - Midwest:  Illinois, Indiana, Iowa, Kansas, Kentucky, Michigan, Minnesota, 
Missouri, Nebraska, North Dakota, South Dakota, Ohio, Oklahoma, 
Tennessee, Wisconsin.

    3 - Gulf Coast:  Alabama, Arkansas, Louisiana, Mississippi, New Mexico, 
Texas.

    4 - Rocky Mountain:  Colorado, Idaho, Montana, Utah, Wyoming.
    5 - West Coast:  Alaska, Arizona, California, Hawaii, Nevada, Oregon, 

Washington. 

For a map of PADDs, see: 
http://www.eia.doe.gov/pub/oil_gas/petroleum/analysis_publications/oil_market_ba 
sics/paddmap.htm. 

Using Locally Generated Factors - Once you have successfully imported your own 
locally generated MOBILE6.2 emission factors into COMMUTER as described in 
Section 2.7, you can direct COMMUTER to apply them in the emission reduction 
calculations by marking the “User-Supplied Emission Factors” box (with an “X”) toward 
the bottom of the screen. Once you activate this option, you must then enter the specific 
calendar year of the emission factors you’ve imported in the “Calendar Year of User EFs” 
input cell. (This input is used to select a specific calendar year from a set of factors 
you’ve imported that may encompass multiple calendar years. Even if you’ve only 
imported emission factors for a single year, you must enter it into this input cell.) 
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NOTE: When you activate the “User-Supplied Emission Factors” 
option, any entries you may have made in the “MOBILE Scenario 
Inputs” cells at the top of the screen are ignored. In addition, the 
vehicle fleet mix and VMT mix by facility type that you've specified 
in your locally generated emissions factors file is automatically 
loaded into the appropriate cells in the “Other Emissions-Related 
Data” screen that follows. 

5.2 Other Emissions-Related Data 

In this final input screen, you will provide additional emission-related inputs that 
COMMUTER will then use in conjunction with the MOBILE6.2 emission factors 
discussed in Section 5.1 to calculate “before TCM” (i.e., existing) and “after TCM” daily 
emissions for the vehicle fleet. It will then determine the resulting emission reductions 
from the TCMs being evaluated. 

Figure 14 shows the Other Emissions-Related Data input screen. Each of the inputs you 
will be required to enter is described below. 

Vehicle Fleet VMT Mix - The light-duty vehicle fleet is composed of nine different 
classes of vehicles, which are listed on the screen. The VMT mix for the vehicle fleet 
refers to the percent of the total travel (VMT) that is driven by each of the nine vehicle 
classes. The emission factors in MOBILE6.2 are based on vehicle class.  COMMUTER 
will calculate emissions for the entire vehicle fleet (referred to as the fleet composite 
emissions) based on the percentage of VMT in each vehicle class, by weighing the 
emission factors together according to the fleet mix input. 

If known, you should supply local data on fleet mix for the analysis area in the “Local” 
column. Only the light-duty vehicle mix (vehicles <8,500 lb.) is required, since the 
strategies analyzed by COMMUTER are not intended to affect travel by heavy-duty 
vehicles (trucks). You may enter the vehicle mix either as a percentage of all light-duty 
vehicles (in which case the total should sum to 100%), or as a percentage of all vehicles 
including heavy-duty vehicles.  If the total you enter is less than 100%, COMMUTER 
will assume that you have selected the second alternative and will normalize the 
percentages to 100%, to represent the fractions of light-duty vehicles. 

55




Figure 14 

Other Emissions-Related Data Input Screen


OTHER EMISSIONS-RELATED DATA 

Use Data 
Default Local Default Explanatory Notes 

Vehicle Fleet VMT Mix 
LDGV - Light-Duty Gas Vehicles 
LDGT1 - Light-Duty Gas Trucks 1 
LDGT2 - Light-Duty Gas Trucks 2 
LDGT3 - Light-Duty Gas Trucks 3 
LDGT4 - Light-Duty Gas Trucks 4 
LDDV - Light-Duty Diesel Vehicles 
LDDT12 - Light-Duty Diesel Trucks 1 & 2 
LDDT34 - Light-Duty Diesel Trucks 3 & 4 
MC - Motorcycles 
TOTAL 

Affected Vehicle Speed (mph) 
Peak Period Average Speed - Freeways 
Off-Peak Period Average Speed - Freeways 
Peak Period Average Speed - Arterials 
Off-Peak Period Average Speed - Arterials 

Percent of VMT by Facility Type 
Freeway

Arterial

Local Road

Ramp

TOTAL (must add to 100%)


#N/A 
#N/A 
#N/A 
#N/A 
#N/A 
#N/A 
#N/A 
#N/A 
#N/A 

0.0% #N/A 

Percentages of total VMT by vehicle type 
Passenger Cars 
0-6,000 lbs. GVWR, 0-3,750 lbs. LVW 
0-6,000 lbs. GVWR, 3,750-3,750 lbs. LVW 
6,000-8,500 lbs. GVWR, 0-5,750 lbs. ALVW 
6,000-8,500 lbs. GVWR, over 5,750 lbs. ALVW 
Passenger Cars 
0-6,000 lbs. GVWR 
6,000-8,500 lbs. GVWR 
Gasoline 
If not 100%, model will normalize 

Average speed (mph) of TCM-affected trips 
50.5 
56.4 
24.2 
26.0 

34.2% 
49.8% 
13.1% 

3.0% 
0.0% 100.0% 

Vehicle Fleet VMT Mix 
MOBILE6 generates emission factors for each of the nine different vehicle classes listed.  Fleet "composite" emission factors 
are then calculated by weighting these emission factors by the percentage of travel (i.e., VMT) in each vehicle class.  The 
default VMT mixes provided by this program are MOBILE6 national default values.  These defaults are calendar year specific; 
you must enter a calendar year under the Fleet Emissions Information screen before the defaults will appear. If you 
are using user-supplied emission factors, the emissions factor import routine will automatically generate and look up a VMT 
mix from your MOBILE6 output file.  If you are using default emission factors and do not enter local data for a VMT mix, the 
model will use the default MOBILE6 VMT mix. 

Only the light-duty vehicle mix (vehicles <8,500 lb.) is required, since the strategies analyzed by COMMUTER are not intended 
to affect travel by heavy-duty vehicles (trucks).  The user may specify the VMT mix either as a percentage of all vehicles, or as 
a percentage of light-duty vehicles.  If the total of the light-duty vehicle categories entered is less than 100%, the model will 
assume that the user is entering the percentage of all vehicles (including heavy-duty) and will normalize these percentages to 
total 100% (representing the fraction of light-duty vehicles). 

Note: GVWR = Gross Vehicle Weight Rating; LVW = Loaded Vehicle Weight; ALVW = Adjusted Loaded Vehicle Weight. 

Affected Vehicle Speed 
Vehicle emissions vary with speed.  The values entered here should represent regional network average speeds during the 
peak and off-peak periods.  Default values supplied are based upon HPMS (Highway Performance Monitoring System) 
averages compiled by urban area size.  

Percent of VMT by Facility Type 
Vehicle emissions vary by roadway facility type because of the different traffic operating characteristics on different facilities 
(e.g., freeway travel typically involves less starting and stopping than travel on other roads).  MOBILE6 defines four facility 
types:  freeways, arterials, local roads, and freeway ramps.  If user-supplied emission factors are provided, the facility mix will 
be read from the user-supplied MOBILE output files and the user does not need to specify the mix.  If default emissions factors 
provided with the COMMUTER model are used, you may either specify a local facility mix or use the default mix that is 
provided with the model. 
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If local data are not available, you can check the boxes in the “Use Default” column to 
use the national default fleet mixes obtained from MOBILE6.2.  Note that the default 
fleet mixes vary by calendar year. 

As indicated in Section 5.1, if you are using your own locally generated emission factors, 
the VMT mix from your MOBILE6.2 emission factor file is automatically loaded into 
these input cells. 

Affected Vehicle Speeds - The values you enter here should represent existing average 
vehicle speeds in your region.  You should be able to obtain data on average travel speeds 
from transportation planning staff at the regional transportation planning agency.  Even if 
you are running a site-specific analysis, enter speeds that represent averages for your 
urban region. 

You will need these values for both peak and off-peak periods, and for freeways as well 
as arterials.*  Peak period travel speed should be the average of travel speeds in the AM 
and PM peak periods, if these values differ. 

CAUTION:  Do not specify travel speeds at a geographic area 
smaller than the county level.  Even if you are performing a site-
specific analysis, the speed inputs should reflect average regional 
network travel speeds that employees at the site experience driving 
to and from work. 

You may also choose to use default travel speeds, shown in Table 2, if local data from the 
regional MPO are not available. These default values have been estimated from national 
highway data. Travel speeds will vary depending on metropolitan area size, since larger 
areas tend to be more congested. 

* In most cases, the MPO for a given region is responsible for both transportation planning and emissions 
analysis.  The MPO maintains local data related to travel demand, speed, and emissions inventories for 
regional planning purposes.  These data are typically available to member agencies (counties, cities, transit 
operators) and businesses.  Metropolitan-level emissions inventory data sets generally provide local data on 
travel speeds by peak and off-peak periods that are generated from the travel demand modeling process and 
used in regional air quality conformity analysis. 
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Table 2

Default Speeds (mph) by Area Size


Period 
Highway 

Type Large 

Urban Area Size 

Medium Small 

Peak Freeway 40.2 46.8 50.5 

Arterial 22.6 23.2 24.2 

Off-Peak Freeway 49.0 54.7 56.4 

Arterial 25.1 25.5 26.0 

VMT by Facility Type 

Vehicle emissions vary by roadway facility type because of the different traffic operating 
characteristics on different facilities (e.g., freeway travel typically involves less starting 
and stopping than travel on other roads).  MOBILE6 defines four facility types:  freeways, 
arterials, local roads, and freeway ramps.  If user-supplied emission factors are provided, 
the facility mix will be read from the user-supplied MOBILE output files and you do not 
need to specify the mix.  If the default emissions factors provided with the COMMUTER 
model are used, you may either specify a local facility mix or use the default mix that is 
provided with the model. 
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